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I.INTRODUCTION 

I.A.HYPERLIPIDEMIA 

Hyperlipidemia is a term that encompasses various genetic and acquired disorders that 

describe elevated lipid levels within the human body. It is a systemic disease, which is 

characterized by elevated lipid levels in blood including total cholesterol (TC), total glyceride 

(TG), and low density lipoprotein cholesterol (LDL-c) and so on. Hyperlipidemia represents 

the subset of dyslipidaemia and a superset of hypercholesterolemia. It is considered as one of 

the five leading cause of death
1
. 

Hyperlipidemia is one of the most important risk factors responsible for many 

cardiovascular and cerebrovascular diseases such as atherosclerosis
 
(increased plasma level 

of low density lipoprotein), hypertension, stroke, fatty liver and becomes the first killer of 

human health
2,3

. It has been reported that nearly 23.6 million people will die from 

cardiovascular diseases originating from hyperlipidemia by 2030
4,

. Many clinical studies 

revealed that reduction of LDL and TC level significantly reduced the risk of the first stroke. 

 

 

 

 

 

 

 

 

 

 
Figure.no.1: Hyperlipidemia 

 
CLASSIFICATION 

 
Hyperlipidemia subdivides into two broad classifications

5
.  

 Primary (familial) hyperlipidemia  

 Secondary (acquired) hyperlipidemia 

 

Familial hyperlipidemia 

Familial hyperlipidemia derives from plethora of genetic disorders that a patient may 

inherent through birth. The primary hyperlipidemia may be treated by antihyperlipidemic 
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drugs. Primary hyperlipidemia was classified according to the Fredrickson classification, 

which is based on the pattern of lipoproteins on electrophoresis or ultracentrifugation
6
. It was 

later adopted by the World Health Organization (WHO).  

Table.no.1: Fredrickson Classification of Primary hyperlipidemia
7
. 

 

 

Acquired hyperlipidemia 

Acquired hyperlipidemia (also called secondary dyslipoproteinemias) often mimic 

primary forms of hyperlipidemia and can have similar consequences. It typically originates 

from alternate underlying etiologic factors. 

 

 

 

Type 

 

Disorder 

 

Cause 

 

Occurrence 

Elevated 

plasma 

lipoprotein 

 

 

I 

 

Familial 

hyperchylomicronemia 

or 

Primary 

hyperlipoproteinemia 

Lipoprotein lipase 

deficiency 

or 

Altered ApoC2 

Very rare 

 

Chylomicrons 

 

 

IIb 

Familial combined 

hyperlipidemia 

Decreased LDL 

receptor and 

increased Apo B 

Commonest LDL and 

VLDL 

 

III 

Familial 

dysbetalipoprotenemia 

Defect in Apo E- 2 

synthesis 

Rare 

 

IDL 

 

IV 

 

Familial 

hypertriglyceridemia 

Increased VLDL 

production and 

decreased excretion 

Common LDL 

 

 

V 

 

Endogenous 

hypertriglyceridemia 

 

Increased VLDL 

production and 

decreased LPL 

 

 

 

Less common 

 

 

 

VLDL and 

chylomicrons 
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ETIOLOGY 

 Genetic factors 

 Unhealthy diet  

 Excessive alcohol consumption  

 Obesity  

 Use of medications such as thiazide diuretics, beta blockers, corticosteroids, estrogen-

progestin contraceptives
8
. 

 Diabetes Mellitus 

 Hypopituitarism  

 Chronic renal failure 

 Nephritic syndrome  

 Hypothyroidism  

 Age 

 Sedentary lifestyle 

 Smoking
9 

 

SYMPTOMS 

A person with hyperlipidemia usually has no signs or symptoms but they are usually 

discovered during routine examination or until it reaches the danger stage of a stroke or heart 

attack. 

 Excessive fat in the blood forming plaques on the walls of the arteries and blood 

vessels which narrows the openings. 

 If hyperlipidemia results in CHD or atherosclerosis at other sites, symptoms may 

include chest pain (angina), heart attack or stroke, acute pancreatitis
10

.  

 In familial, or inherited, hyperlipidemia, there may be yellowish fatty growths around 

the eyes or the joints.  

 Very high triglyceride levels may result in the formation of nodules on the elbows or 

knees, or the appearance of multiple, pimple-sized, yellowish skin eruptions. 

 Swelling of organs such as the liver, spleen, or pancreas (pancreatitis). 

 Blockage of blood vessels in brain and heart. 
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COMPLICATIONS OF HYPERLIPIDEMIA 

 

 

 

 

 

 

 

Figure.no.2: Complications of hyperlipidemia
11

 

DIAGNOSIS 

To determine if and when medications are needed, a physician will look at the 

patient's lipid profile and their risk factors. If the person has high cholesterol levels, 

monitoring and treatment are likely to be necessary. 

 

 

 

 

 

 

 

 

 

Figure.no.3: Lipid profile 
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PREVENTION 

 Lifestyle options are the best way to prevent and treat hyperlipidemia. This involves a 

"heart-healthy" diet, regular exercise, avoiding or quitting tobacco use, and 

maintaining a healthy weight. 

 A low-fat diet include a variety of whole fruits and vegetables, plenty of fibre, whole 

grains, fish, nuts, legumes, olive oil or oil rich in monounsaturated fats are 

recommended 

 Regular exercise can help reduce LDL, total cholesterol, and triglyceride levels. It can 

also boost HDL, which helps to remove the bad cholesterol out of the blood 

encourage weight loss. 

 Smoking promotes plaque build-up on the walls of the arteries, increases LDL levels, 

and it encourages the formation of blood clots and inflammation. Quitting smoking 

will result in higher HDL reduces the risk of cardiovascular disease
12

. 

TREATMENT 

The most commonly prescribed medicines for hyperlipidemia treatment are  

 HMG CoA Reductase Inhibitors – Atorvastatin, Simvastatin 

 Fibrates – Fenofibrate, Clofibrate 

 Bile acid sequestrants – Colesevelam, Colestipol, Cholestyramine 

 Nicotinic acid – Niacin 

 Cholesterol Absorption Inhibitors – Ezetimibe 

 Other drugs – Vitamin E
13

. 

There are also new medications called PCSK9 inhibitors being studied for people with 

cardiovascular disease that need additional lowering of their LDL-c.  
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Figure.no.4:  Agents used in the treatment of Hyperlipidemia 

NEED FOR NEW ANTIHYPERLIPIDEMIC DRUGS 

Some of the reasons necessitating the emergence of newer antihyperlipidemic drugs are  

 

 To improve the current course of treatment by shortening its total duration.  

 To facilitate drug compliance by providing with less intensive supervision. 

 Drug with lesser frequency of administration which permits widely spaced 

intermittent treatment.  

 To reduce the side effects such as stomach irritation, heart problems, and liver 

and kidney damage.  

 To design a drug with higher efficacy and more specific in action by inhibiting 

the enzyme target which is responsible for causing hyperlipidemia.  
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I.B. DRUG DESIGN 

In the field of new discovery and development, Computational techniques are rapidly 

gaining popularity, implementation and appreciation. Drug design is an inventive process of 

finding a new medication based on the knowledge of the biological target also known as 

rational drug design
14

. Drug design is frequently based on computer modelling techniques 

which are often referred to as Computer Aided Drug Design (CADD). 

 

Different terms are being applied to this area, including computer aided drug design 

(CADD), computational drug design, Computer aided molecular drug design (CAMD), 

computer aided molecular modelling (CAMM), rational drug design, In silico drug design 

and computer aided rational drug design. Both computational and experimental techniques 

have complementary roles in drug discovery and development
15

. 

 
CADD ENTITIES 

 Drug discovery and development process is streamlined by using the computing 

power. 

 Chemical and biological information about ligands, targets in process of identification 

and optimization of new analogs. 

 Design of In silico filters to eliminate compounds with undesirable properties 

(ADMET) and select the most promising candidates. 

 

 

Drug Design 

 Ligand based Drug Design 

 Structure based Drug Design 

 

Ligand Based drug design 

 Ligand based drug design (Indirect drug design) depends on knowledge of all other 

molecules which binds to the biological target. 

Structure based drug design 

 Structure based drug design (Direct drug design) mainly depends on knowledge of the 

three dimensional structure of the biological target
16

. 
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PHARMACOPHORE MODELING 

 

Pharmacophore modeling studies have become one of the major tools in the field of 

drug discovery. In 1909, Paul Ehrlich introduced the concept of Pharmacophore, who defined 

the pharmacophore as “a molecular framework that carries (phoros) the essential features 

responsible for a drug’s (Pharmacon) biological activity‟. The IUPAC defines “A 

pharmacophore is ensemble of stearic and electronic features that is necessary to ensure the 

optimal supra-molecular interaction with a specific biological target and to trigger or block its 

biological response”
17

. 

 

Pharmacophore features 

 Hydrogen bond acceptor 

 Hydrogen bond donor 

 Hydrophobic 

 Hydrophobic aliphatic 

 Hydrophobic aromatic 

 Positive ionizable 

 Negative ionizable 

 Ring aromatic 

 

In order to identify novel ligands, the pharmacophoric features should match different 

chemical moieties with similar properties. A well-defined pharmacophore model includes 

both hydrophobic volumes and Hydrogen bond vectors. 

Various ligands based and structure based methods involving pharmacophore 

modeling have been developed and extensively applied in the field of virtual screening, De 

novo design and lead optimization. 

 

DOCKING STUDIES 

Virtual screening techniques range from simple one up to sophisticated virtual 

docking methods aimed at fitting putative ligand molecules into the target receptor site
18

. In 

the field of drug design, docking predicts the preferred orientation of one molecule to the 

other when they bound to each other to form a stable complex
19

. Docking plays an important 

role in the molecular modelling as it is used to predict the binding orientation (affinity) of 

drug candidate to their protein targets
20

. 
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Docking process 

The docking process mainly involves the prediction of ligand conformation and 

orientation (posing) with active binding site of the target. Molecular docking process is 

compared to “lock-and-key” model. Here, the protein is considered as the “lock” and the 

ligand as a “key”. The ligand and the protein adjust their conformation to achieve an overall 

“best-fit” which is referred as “induced-fit”
21

. 

 

Docking methodology 

Docking is an interactive procedure which generates the random ligand conformations 

for specified number of times, number of maximum trials
22

.  

Steps involved in docking 

 

 Protein preparation. 

 Ligand Preparation. 

 Docking Procedure. 

 Visualization / Interpretation of Docking. 

 

Protein Preparation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure.no.5: Preparation of Protein 
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Ligand Preparation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure.no.6: Preparation of ligands 

Docking procedure 

 

 

 

 

 

 

 

 

 

 

Figure.no.7: Docking calculations 
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I.C. TARGET PROFILE 

PROPROTEIN CONVERTASES 

Proprotein convertases are a family of enzymes involved in converting precursors of 

secretory proteins such as hormones, enzymes and receptors into bioactive molecules at their 

intended target tissue. These enzymes are part of regulatory pathways that help the body to 

maintain homeostasis. 

PCSK9- PROPROTEIN CONVERTASE SUBTILISIN/KEXIN TYPE 9  

PCSK9 (Proprotein convertase subtilisin/kexin type 9) was first described in 2003 in 

its active form, PCSK9 regulates cell surface receptors, in particular the LDL receptor. The 

enzyme encoded by the PCSK9 gene is primarily expressed in the liver.  

3D structure of PCSK9 

 

 

 

 

 

 

 

Figure.no.8:3D Structure of PCSK9 protein 

Biogenesis and structure of PCSK9 

The human PCSK9 gene, initially called 'neural apoptosis-regulated convertase 1' 

(NARC1), was discovered by Seidah et al., who reported the identification of the ninth 

member of the mammalian proprotein convertase family located on chromosome 1p32.3. 

The PCSK9 gene on the short arm of chromosome 1 is 25 kb long and contains 12 exons and 

11 introns. PCSK9 encodes an inactive glycoprotein (pre-PCSK9) with 692 amino acids 

comprising four major components: a signal sequence (1-30) and N-terminal prodomain (31-

152), followed by a subtilisin-like catalytic domain (153-425) and a C-terminal domain (426-

692, also called the V domain).  
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Once the signal peptide is cleaved from pre-PCSK9 in the endoplasmic reticulum, 

pro-PCSK9 (31-692) is formed and then converted to mature secretory PCSK9 through 

autocatalytic cleavage of the prodomain between Gln152 and Ser153 in the Golgi apparatus.  

However, unlike the other proprotein convertases, the cleaved prodomain of PCSK9 remains 

tightly associated with the catalytic domain, where it inhibits further catalytic activity. 

 

 

 

 

 

 

 

 

 

 

 

Figure.no .9: Gene location (human) and structure of PCSK9 

PCSK9 binds to LDLRs on the cell surface, leading to their degradation. The binding 

site of PCSK9 localizes to the EGF(A) (epidermal growth factor A) domain of the LDLR. 

The binding surface of PCSK9 is formed primarily by residues 367-381, constructing an 

exposed, slightly convex ~500 Å 2 region. The key interactions of PCSK9 with EGF(A) are 

made by an antiparallel β-sheet formed between residues 377-379 of PCSK9 and 308-310 of 

EGF(A).  

Physiological Role of PCSK9 

One of the most important PCSK9 functions is participation in LDLR expression 

regulation, leading to regulation of the LDL cholesterol level in the blood. Additionally, 

PCSK9 carries out two quasi-independent functions: on the one hand, it decreases the LDLR 

density on hepatocytes surface, and on the other hand, it prevents the reverse capture of the 

newly synthesized VLDL, letting them reach the peripheral tissues. However, it should be 
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kept in mind that PCSK9 is able to interact with other receptors and thus may possess a far 

broader spectrum of activity which has not been completely investigated to date. 

Mechanism of Regulation of PCSK9-Mediated LDLR Expression in Hepatocytes 

The clearance and catabolism of serum LDL occurs in the liver. These are the 

hepatocytes which are major regulators of the LDL level, expressing LDLRs which capture 

the LDLs and remove them from the blood plasma. The LDL/LDLR complex enters a 

hepatocyte within clathrin vesicles, gradually merging with the endosomes. The endosomal 

acidic medium activates a complex dissociation and the released LDLRs return to the 

hepatocyte surface, continuing their job of removing LDL from the serum.  

It is known that the calcium-mediated interaction of the PCSK9 catalytic domain with 

the A-EGFP repeat of LDL takes place on the hepatocytes surface. After the LDL binds to 

the LDLR, the LDL/LDLR/PCSK9 complex relocates into the cell within the clathrin vesicle. 

The low-pH medium in the endosomes promotes the separation of the LDL from the complex 

and increases the PCSK9/LDLR binding due to additional ion–ionic interactions between the 

PCSK9 prodomain and the LDLR.  

As a result, the PCSK9 holds the LDLR in the open conformation like a pillar, 

without acting proteolytically, and prevents the transition in the closed conformation that is 

necessary for the return to the cell surface, which leads to a decrease in receptor expression 

on the hepatocyte surface and, accordingly, a decrease in LDL clearance from the plasma. 

Consequently, PCSK9 plays a very important role in the serum LDL cholesterol level 

regulation. 

 

Figure.no.10: PCSK9-mediated regulation of LDLRs 
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TIMELINE OF DEVELOPMENTS IN THE HISTORY OF PCSK9 INHIBITORS 
 

Figure.no.11: Timeline of PCSK9 inhibitors development. 
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II. SYNTHETIC CHEMISTRY 

OXADIAZOLE 

 Oxadiazole is a five membered heterocycle which contain two carbons, two nitrogen, 

one oxygen and two double bonds having general formula C2H2ON2. Oxadiazole is 

considered to be derived from furan by replacement of two methylene (-CH=) group by two 

pyridine type nitrogen (-N=)
24

.  

 

 

 

It undergoes number of reactions including electrophilic substitution, nucleophilic 

substitution, thermal and photochemical reaction. There are four possible isomers of 

oxadiazole (a,b,c,d) depending on the position of nitrogen atom in the ring and are numbered 

as shown below. 

 

 

 

 

 

Isomers of Oxadiazole 

Out of its four isomer 1,3,4- Oxadiazole is widely exploited for various applications. 

A wide variety of substituted 1,3, 4-oxadiazole have attracted attention in the field of drug 

discovery because of their wide range of pharmacological activities such as antibacterial, 

antifungal, analgesic, anti-inflammatory, antiviral, anticancer, hypolipidemic, anticonvulsant, 

and CNS stimulants properties
25-27

. 
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AMINO TRIAZOLE 

 

Triazoles are five-membered rings, which contain two carbon and three nitrogen 

atoms, with a molecular formula of C2H3N3.  

 

 

 

 

According to the position of nitrogen atoms, triazoles exist in two isomeric forms – 

1,2,3-triazole and 1,2,4-triazole
28

. 1,2,4-triazoles and their fused heterocyclic derivatives are 

the primary heterocycles in the field of medicine. 1,2,4-triazole exist in two tautomeric forms. 

 

 

 

 

It possesses various pharmacological activities such as anti-inflammatory, antifungal, 

antidiabetic, anticancer, antioxidant, antihyperlipidemic and anticonvulsant activities
29

. 

BENZOXAZOLE 

Benzoxazole (1-oxa-3aza-1H indene) is an aromatic organic compound with a with a 

molecular formula C7H5NO, benzene fused oxazole ring structure
30

.  
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A slight change in the substitution pattern of benzoxazole nucleus causes 

distinguishable difference in their pharmacological activities. The substitution at second 

position in benzoxazole skeleton is influential for the biological activity of the molecule
31

. 

Benzoxazole derivatives possess diverse variety of pharmacological activities such as 

anticancer, anticonvulsant, antimicrobial, antiviral, antihyperglycemic, hypolipidemic, 

herbicidal, antiparasitic and anti-inflammatory activity
32

. 
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III. LITERATURE REVIEW 

LITERATURE REVIEWS RELATED TO HYPERLIPIDEMIA 

Haixia Ge et al., (2021)
33

 designed and performed biological evaluation of novel 

tetrahydroprotoberberine derivatives to reduce SREBPs expression for the treatment of 

hyperlipidemia. Results showed that two compounds significantly reduced both intracellular 

TC and TG content. Compound 49 displayed superior bioavailability and hence it was a 

promising candidate for the treatment of hyperlipidemia. 

 

 

 

 

Compound 49 

Hill M et al., (2021)
34

 briefly outlined the etiology, pathophysiology and treatment of 

hyperlipidemia condition.  

Chenglin Wu et al., (2019)
35

 designed and synthesized series of novel 

tetrahydroprotoberberine derivatives as Proprotein convertase subtilisin/kexin type 9(PCSK9) 

modulators for the treatment of hyperlipidemia. Results showed that 8 compounds exhibited 

excellent activities in downregulating hepatic PCSK9 expression than berberine. Among this 

compound 22 promoted hepatic LDLR expression in a dose dependent manner in HepG2 

cells. Hence, compound 22 found to be a promising lead compound for the development of 

PCSK9 modulator for the treatment of hyperlipidemia. 

 

 

 

 

Compound 22 
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LITERATURE REVIEWS RELATED TO BIOLOGICAL TARGET PCSK9 

Nikolay Kuzmich et al., (2022)
36

 reviewed PCSK9 as a target for development of a new 

generation of hypolipidemic drugs. The prevention of its interaction with LDL receptors 

leads to an increase in the uptake of cholesterol rich atherogenic LDL from the blood stream. 

Hence low-molecular weight PCSK9 inhibitors could be a worthy alternative to produce drug 

of minimal side effects. 

Nabil A Elshourbagy et al., (2022)
37

 discovered and developed oral small molecule 

PCSK9/LDLR antagonist. PCSK9 is a well validated target for the treatment of 

hypercholesterolemia. Virtual screening and SAR study was performed to identify the potent 

antagonist.  Further in vivo studies carried out in the most potent nano formulation P-21 at 

1,3,10 and 30mg/kg in C57BL/6 mice fed a high fat diet shows a 20, 40, 60 and 90% LDL-C 

lowering respectively.  

Munchalika Jaitrong et al., (2021)
38

 designed novel series of Berberine (BBB) derivatives 

based on molecular docking studies to serve as MTDLs for PCSK9 and HMGCR.  Results 

showed that all the designed compounds were identified as the potent multitarget inhibitors 

because the increase of hydrogen bond, hydrophobic and electrostatic interactions were 

observed. The introduction of nitro-group plays a vital role in the binding pose of the BBB 

derivative. Finally, in silico study confirmed that most of the compounds pass the drug 

likeliness properties. 

Thomas J Tucker et al., (2021)
39

 developed a series of novel, highly potent and orally 

bioavailable next generation Tricyclic peptide PCSK9 inhibitors. Optimized molecules such 

as 44 demonstrated sufficient oral bioavailability to maintain therapeutic levels in rats and 

cynomolgus monkeys after dosing with an enabled formulation. 
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Tian-Yun Fan et al., (2021)
40

 synthesized series of berberine derivatives and evaluated for 

their activities on down regulating the transcription of biological PCSK9 in HepG2 cells, 

taking BBR as the lead. SAR analysis revealed that 2,3-dimethoxy moiety might be 

beneficial for activity. Among them, compound 9k showed increased LDLR expression and 

LDL-C clearance via down-regulating PCSK9 protein. Therefore, 9k might have the potential 

to be a novel PCSK9 transcription inhibitor for the treatment of Atherosclerosis, worthy for 

further investigation. 

 

 

 

 

Compound 9k 

Shengato Xu et al., (2019)
41

 summarised the overview recent development of small 

molecules as inhibitors of PCSK9. Two PCSK9 blocking monoclonal antibodies alirocumab 

and evolocumab were approved in 2015. However the high cost of PCSK9 antibody drugs 

impede their prior authorization practices and reduced their long term adherence. Hence, 

different approaches have been pursued to modulate the functional activity of small 

molecules as inhibitors of PCSK9. 

Johan Frostegard et al., (2018)
42

 identified that Proprotein convertase subtilisin/kexin type 

9(PCSK9) inhibitors have unexpected anti-inflammatory effects. Researchers at karolinska 

instituted have examined how immune cell from human atherosclerotic plaques are effected 

by Proprotein convertase subtilisin/kexin type 9 (PCSK9).These dendritic cell then mediated 

the activation of T cell in to pro-inflammatory phenotype Proprotein convertase 

subtilisin/kexin type 9(PCSK9) inhibition reversed the effect of oxidized LDL on immune 

activity. 

Niki Katsikii et al., (2017)
43

 identified that the Proprotein convertase subtilisin/kexin type 9 

that shaping the future for further cardiovascular outcomes research with Proprotien 

convertase subtilisin/kexin type 9 inhibition in subjects with elevated risk by (FOURIER 

TRIAL). They concludes that Proprotein convertase subtilisin/kexin type 9 inhibitors are now 

an evidence based option for patients who do not tolerate statins. 
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Vikas reddy et al., (2016)
44

 identified the potential inhibitors for lower cholesterol level by 

inhibiting Proprotein convertase subtilisin/kexin type 9 (PCSK 9). In these docking studies, 

they conclude that two compounds such as ZINC85625485 and ZINC85625406 may act as 

the potential inhibitors of Proprotein convertase subtilisin/kexin type 9 receptor. 

 

 

 

 

ZINC85625485 

LITERATURE REVIEWS RELATED TO BASIC NUCLEUS 

Xi Khai Wong et al., (2020)
45

 summarized the current developments of benzoxazole in drug 

discovery. Shifa biomedical corp. explored the possibility of benzoxazole based compounds 

in inhibiting PCSK9. Among all the compounds synthesized, the benzoxazole 73 is most 

potent with an IC50 value of 0.6µM. when the benzoxazole moiety is replaced with other 

functional groups, the potency was compromised. Hence it is inferred that the benzoxazole 

moiety play a vital role in providing good PCSK9 inhibitory activity for an excellent LDL-c 

lowering effect. 

 

 

 

 

Benzoxazole 73 
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Jean Charles Fruchart (2017)
46

 outlined modulation of the unique receptor cofactor binding 

profile to identify the most potent molecule induce PPAR-γ mediated beneficial effects. A 

new therapeutic approach for development of pemafibrate, a novel selective PPAR-γ 

modulator. A major outcome study, PROMINENT will provide definitive evaluation of the 

role of pemfibroate for management of atherogenic dislipidemia. 

 

 

 

 

Wenbin Wang et al., (2015)
47

 designed a series of isoflavone amide with isoflavone in place 

of scaffold of 2- aryl benzoxazole of CETP inhibitors. Twelve new compounds were 

synthesized and their inhibitory activities were assayed. The results indicate that HY-2C 

exhibited favourable antihyperlipidemic activity.  

Mayura Kale et al., (2013)
48

 summarized the biological potential of various heterocyclic 

scaffolds with antihyperlipidemic potential. 

Ashraf Y. Khan et al., (2012)
49

 designed and synthesized series thiazolidinedione 

derivatives by incorporating pharmacological significant heterocycles like substituted 

thiazole, triazole and oxadiazole moieties. These heterocycles are linked to central phenyl 

ring via heteroatom linkage with one or two carbon spacer as the structure analogue of 

pioglitazone by employing multistep synthetic protocol. The synthesized compounds were 

screened for their in vivo hypolipidemic and hypoglycemic activity. Results showed that 

compound 10h, 11c and 11d significantly decreased serum TC level.  

 

 

 

 

Compound 10h                               Compound 11c 
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Camerson J Smith et al., (2010)
50

 synthesized series of 2-arylbenzoxazole as inhibitor of 

CETP. SAR studies focused on variation of the benzoxazole moiety were found to be 

beneficial for CETP Inhibition. Substitution at 5
th

 and 7
th

 position of benzoxazole moiety was 

found to be beneficial for CETP inhibition. Compound 47 was found to be the most potent 

inhibitor in this series and inhibited CETP with an IC50 of 28 nm. 

Gamal A. Idrees et al., (2009)
51 

synthesised series of 2-(naphthalene-2-yloxy)propionic acid 

derivatives and the hypolipidemic activity of the new compounds as well as the intermediate 

acid 2 was evaluated in the high cholesterol diet fed hyperlipidemic rat model. The results 

showed that the S-alkylated mercaptotriazole 8b and the 1,3,4-oxadiazole 9 produced striking 

reduction of serum levels of total cholesterol (TC) ,triglycerides (TGs), low density 

lipoproteins (LDLs) and elevation of serum high- density lipoprotein being more active than 

the reference gemfibrozil. 

  

 

 

 

 

 

LITERATURE REVIEWS RELATED TO PHARMACOLOGICAL ACTIVITY 

Anusha Govindula et al., (2019)
52

 investigated in vivo antihyperlipidemic activity of 

ethanolic extract of Bauchinia accuminata in Atherogenic diet induced rats. Preliminary 

photochemical screening showed the presence of flavonoids, alkaloids, steroids, terpenoids. 

Results showed that a significant reduction in the TC, VLDL, TG and increase in HDL level 

with ethanolic extract at a dose of 400 mg/kg then 200 mg/kg and the standard Atorvastain. 

Prabhu Mahendra et al., (2019)
53

 synthesized some substituted morpholine derivatives and 

evaluated it’s in vivo antihyperlipidemic activity. In silico molecular docking studies for the 

synthesised Morpholine derivatives with PPAR-α protein showed the energy level ranging 

from -6.74kcal/mol to -8.83kcal/mol. the compound 1C which shows least binding energy 

taken for further in vivo studies. Morpholine derivatives shows significant reduction in TC 
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and TG in blood compared to the standard drug. Hence the morpholine compounds exhibit 

significance towards the anorectic activity. 

 

 

 

 

  1C 

Muhammad Tahir Aeel et al., (2018)
54

 synthesized series of phenolic derivatives 4a-e and 

6a-e with the aim of developing antihyperlipidemic agents. In silico docking studies revealed 

that compound 4a and 6a exhibited maximum binding affinity. In vivo studies showed that 

compound 4a as more hypolipidemic than the Atorvastatin against hyperlipidimic model. 

 

 

 

 

4a 

Safia A K et al., (2013)
55 

studied the antioxidant, hyperlipidemic and anti-obesity effect of 

Mommordica diocia Roxb fruit extracts. The results suggest that the MDR extract shows 

hypolipidemic and anti-obesity activity. Methanolic extract showed more potential than FMD 

because of high phenolic and flavonoid content. 

LITERATURE REVIEWS RELATED TO COMPUTER AIDED DRUG DESIGN 

Rida Zainab et al., (2021)
56

 described finding inhibitors for PCSK9 using computational 

methods. The protein ligand interaction helps to understand the actual mechanism for the 

pharmacological action. The result showed that (S) - candine may act as a potential inhibitor 

against atherosclerosis for the development of new PCSK9 inhibitory drugs in future in vivo 

research. 
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Fernando, D.Prielo Martinez (2019)
57

 outlined the importance of the computational drug 

design methods in the Drug Discovery process. 

Praveen K Guttula et al., (2017)
58

 performed molecular docking studies on selected 

phytocompounds against PCSK9-LDL receptors (homosapiens) for coronary artery disease. 

The docking studies performed for Resveratrol, Ellagic acid, quercetin with target protein 

using Autodock docking software and the results showed that Ellagic acid compound have 

greater inhibition of enzyme activity compare to Resveratrol and Quercetin. 
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IV. AIM AND OBJECTIVE 

AIM 

The main aim of the study is to identify, design, and synthesize certain newer 

heterocycles as potent antihyperlipidemic agents with good predicted capability to inhibit the 

PCSK9 involving Computational drug designing methods. 

OBJECTIVE OF WORK 

The plan of work includes the following steps 

 Selection of target responsible for producing hyperlipidemia from the literature 

review which is carried out as part of the current research. 

 Identification of common pharmacophoric features responsible for inhibiting 

Proprotein Convertase Substilsin/Kexin type 9. 

 Designing series of leads that selectively modulate the activities of Proprotein 

Convertase Substilsin/Kexin type 9 for exhibiting antihyperlipidemic activity. 

 The binding mechanism of PCSK9 receptor and newly designed leads has to be 

studied using molecular docking with Autodock4.2.6 (PDB ID: 2P4E). 

 Optimization of designed leads based on the Drug likeliness, ADMET and Toxicity 

prediction using Molinspiration, Osiris software. 

 Synthesis of certain optimized leads based on the synthetic feasibility and high dock 

score. 

 Characterization of chemical nature of the synthesized compounds by IR, 
1
H-NMR, 

and LC-MS. 

 In vivo Pharmacological screening studies of the synthesized compounds.  

 Evaluation of acute oral toxicity studies. 

 Evaluation of Antihyperlipidemic activity. 
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PLAN OF WORK 

 IDENTIFICATION AND SELECTION OF TARGET  

PHARMACOPHORE MODEL IDENTIFICATION 

GENERATION OF VIRTUAL LIBRARY OF SCAFFOLDS 

MOLECULAR DOCKING STUDIES 

LEAD OPTIMIZATION 

SYNTHESIS OF SELECTED LIGANDS 

CHARACTERIZATION OF SYNTHESIZED COMPOUNDS BY 

TLC, IR, 1H-NMR, LC- MS 

IN VIVO EVALUATION  

ACUTE ORAL 

TOXICITY STUDY 

ANTIHYPERLIPIDEMIC 

ACTIVITY 
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V.A. DRUG DESIGN 

V.A.I. MATERIALS AND METHODS 

1. SELECTION OF TARGET 

Protein Data Bank (PDB) is a crystallographic database for three-dimensional 

structural data of large biological molecules, such as Proteins, Nucleic acid and Complex 

assemblies. The targets creating the greatest enthusiasm at this time for the treatment of 

Hyperlipidemia includes HMG Co-A reductase, ATP Citrate lyase, Apolipoprotein B, 

PCSK9, Angiopoietin-like 3(ANGPTL3), Sterol regulatory element binding protein(SSEBP)  

and PPAR-α activators
36

. Ultimately human trials will help to understand the potential risks 

and benefits of these novel approaches across a number of diseases. 

An elaborate literature survey was done to understand the concepts and facts behind 

the hyperlipidemia diseases. Based on the gained knowledge Proprotein convertase 

substilsin/kexin 9(PCSK9) was chosen as the target for hyperlipidemia treatment. PCSK9 has 

medical importance because it acts in lipoprotein homeostasis. Agents that block PCSK9 can 

lower the LDL-C particle concentration. Hence, PCSK9 is considered as an attractive and 

most effective target in the field of discovering newer antihyperlipidemic drugs. 

Some of the efficient PDB enzyme targets were selected with lower resolution and the 

results are illustrated in Table.no:2, from which the highlighted best PDB target (2P4E) was 

employed in this study. 

Table.no.2: List of PDB for PCSK9 target for Hyperlipidemia 

 

S.NO CODE RESOLUTION 
(AO) 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

4NMX 

2QTW 

2P4E 
4LKC 

2PMW 

3H42 

2W2N 

5OCA 

2W2Q 

2W2M 

3BPS 

4NE9 

1.85 

1.90 

1.98 
2.20 

2.30 

2.30 

2.30 

2.30 

2.33 

2.40 

2.41 

2.60 
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  13 

14 

15 

 

2W2P 

2W2O 

4OV6 

 

2.62 

2.62 

2.60 

 

 

2. PHARMACOPHORE MODELING
59

 

a. Pharmacophore identification 

A Pharmacophore is defined as “a set of structural features in a molecule that is 

recognized at a receptor site and is responsible for that molecule’s biological activity”. 

Pharmacophore modeling correlates the biological activity with the spatial arrangement of 

various features in set of active analogues. 

 When reviewing the efficient journals and research articles, pharmacophore model 

consisting of one hydrogen bond acceptor (HBA), one hydrogen bond donor (HBD), aromatic 

ring features was identified as the best model for designing as PCSK9 inhibitor
44

. Hence the 

above best pharmacophoric model was used as 3D structural query to screen the chemical 

databases for retrieving new potent PCSK9 inhibition. 

b. Database screening  

Scaffold hopping, or chemo type switching, is a technology that modifies the 

chemical scaffold of a bioactive compound retaining the activity and key interaction points, 

or the interacting molecular fragments of the parent compound.  

Based on the above quoted literature facts in designing potent PCSK9 inhibitors, the 

target screening library was designed by using molecular fragments from a relatively narrow 

and low molecular weight, selected diversity at both the putative “scaffold” core. The 

analogue library was generated by modifying the respective functional groups with sterically 

and conformationally allowed substituents using the reagent database and a combinatorial 

design model. 

 

Construction of a Large Virtual Scaffold Library 

A library consisting of nearly new150 lead molecules as potent PCSK9 inhibitors was 

generated based on the knowledge of binding interaction of ligand with the protein and also 

the common features necessary for the biological activity of molecule. The chemical features 

like one hydrogen bond acceptor (HBA), one hydrogen bond donor (HBD), one aromatic ring 



EXPERIMENTAL WORK 

Department of Pharmaceutical Chemistry, COP, MMC. Page 29 

features were used to screen knowledge database (Table.no:3). Virtual scaffold library 

consisting of newly designed 150 molecules each as Proprotein convertase subtilisin/kexin 

type 9 (PCSK9) inhibitor was constructed as depicted in the Figure.no:12 

Table.no:3 Molecular fragments used in construction of library of PCSK9 inhibitor 

HBD HBA AROMATIC RING 

 

Imidazole, Thiadiazole,  

Benzimidazole, 

Aminothiazole, Phenolic-OH, 

Aniline, Alkyl amines, 

Oxazole.  

 

C-O-C of Oxadiazole, C=O of 

aliphatic and aromatic amides, 

C=O of aromatic ketones, 

C=O of diamide.  

 

 

Phenol, Pyrrole, Pyridine, 

Indole,Quinoline, 

Benzimidazole, 

Benzthiazole, Thiadiazole, 

Pyrazole. 

 

2. MOLECULAR DOCKING STUDY
38

 

In the current molecular simulation study, Autodock 4.2.6 software was used for the 

prediction of binding energy of the ligands with PCSK9. 

a. Preparation of target protein 

The three-dimensional structure of Proprotein convertase substilsin/kexin type9 

(PCSK9) was acquired from the Protein Data Bank as PDB format (PDB ID:2P4E-

Homosapien, Resolution 1.8 Å) (www.rcsb.org/pdb).Co-crystalized ligands, cofactors and 

water molecules were removed from the crystal structure using Molegro Molecular viewer. 

The two chains (P, A) of the target enzyme were exported from the Molegro Molecular 

viewer in .pdb format and saved as protein.pdb in a repository work folder – destination 

folder. 

 

b. Ligands preparation 

The two-dimensional (2D) chemical structures of the ligand molecules were sketched 

by using ChemDraw Ultra 12.0 and saved in MDL Mol format. The energy minimizations of 

the ligands were carried out with Chem3D Pro 12.0. Energy minimized ligand molecules 

were saved as ligand.pdb in the same repository workfolder.  
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c. Docking studies  

Steps involved in docking 

i.Preparation of protein: 

  

  

  

  

  

  

 Preparation of Ligand: 

 

ii. Preparation of Ligand 

 

 

 

 

 

 

 

iii. Grid generation: 

 

 

 

 

 

 

 

 File > Read molecule > Select Protein file in .pdb format 

 Edit > Charges > Compute Gasteiger (for arbitrary molecules) 

 Edit >Hydrogens> Add > Polar only 

 Edit >Hydrogens> Merge Non-polar 

 Edit >Misc> Repair Missing Atoms 

 File > Save > Write PDB > Sort Nodes(Check) 

 Ligand > Input > Open > Select Ligand file in pdb format 

 Edit > Charges > Add Kollman charges 

 Ligand > Torsion > Choose torsion [Rotatable bonds are shown in green, 

and non-rotatable bonds are shown in red. Bonds that are potentially 

rotatable but treated as rigid, such as amide bonds and bonds that are made 

rigid by the user, are shown in magenta]. 

 Ligand > Torsion > Set number of torsions 

 Ligand > Output > Save as .pdbqt 

 Grid > Macromolecule > choose Protein > Select molecule > Save as .pdbqt 

 Grid > Set map types > choose Ligand > Select ligand 

 Grid > Grid Box > Set the Grid Box dimensions ( i.e., XYZ co-ordinates100 

x 100 x 100 ) > File > Close Saving current 

 Grid > Output > Save as grid.gpf ( Grid Parameter file ) 



EXPERIMENTAL WORK 

Department of Pharmaceutical Chemistry, COP, MMC. Page 31 

iv. Preparation of Docking Parameters: 

 

 

 

 

 

 

 

v. Visualization / Interpretation of Docking 

 

 

 

 

 

 

 

 

The Binding energy and the inhibitor constant values were predicted by performing 

the docking studies. The binding scores of ligands were tabulated in Table.no.4. then the 

result.pdb file was viewed in the Molegro Molecular viewer. Electrostatic, hydrogen bond 

and steric interactions between the various amino acids in the target protein and ligands were 

observed. These interactions are depicted in Figure.no.13. 

 

  

 

 

 

 

 Docking > Macromolecule > Set Rigid Filename > Select protein.pdbqt> 

Open 

 Docking > Ligand > Select Ligand > Accept 

 Docking > Search Parameters > Genetic Algorithm 

 Docking > Output > Lamarckian GA > Save as dock.dpf ( Dock Parameter 

File ) 

 

 autogrid4.exe –p grid.gpf–l grid.glg( wait for the response ) and 

 autodock4.exe –p dock.dpf–l dock.dlg. 

 

 Analyze> Docking >Select dock.dlg 

 Analyze> Macromolecule > Select Protein 

 Analyze> Conformations > Play ranked by energy 

 Set Play options > Build H-Bonds > Show info > Build Current > Write 

complex > Save as result.pdb. 

 Analysis > Docking > Show interaction (Specialized visualization which 

highlights the interactions between the docked conformation of the ligand 

with the receptor) 
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4. IN SILICO DRUG LIKELINESS SCREENING 

Drug likeness is a qualitative concept indicated by the molecular properties that affect 

absorption, distribution, metabolism, excretion and toxicity (ADMET) of a compound. Drug 

likeliness is described as a complex balance of various molecular properties and structural 

feature which determine whether particular molecule is similar to the known drugs
60

. These 

properties are mainly hydrophobicity, electronic distribution, hydrogen bonding 

characteristics, molecule size and flexibility and also presence of various pharmacophoric 

features that influence the behaviour of molecule in a living organism including 

bioavailability, affinity to proteins and many others
61

. 

Drug likeliness properties of the newly designed PCSK9 inhibitors was determined by 

employing different Online softwares like Molinspiration and Osiris property explorer.  

 

a. Lipinski’s Rule of Five 

Lipinski’s rule of five is a rule of thumb to evaluate drug likeliness, or to determine if 

a chemical compound with a certain biological activity. The rule was formulated by 

Christopher A. Lipinski in 1997, based on the observation that most medication drugs are 

relatively small and lipophilic molecules.  

Lipinski’s rule says that, in general, an orally active drug has no more than one 

violation of the following criteria, 

 Log P value should be less than 5 

 Hydrogen bond donor less than 5 

 Hydrogen bond acceptor less than 10 

 Molecular weight under 500 Daltons and 

  Not more than 10 rotatable bonds. 

 

Molinspiration online software tool 

Molinspiration is an online tool used to evaluate the in silico pharmacokinetic 

properties of ligands based on the Lipinski rule of five. It was employed to predict the 

molecular properties like Molecular weight, Log P, Total Polar Surface Area, number of 

Hydrogen Bond Donors & Acceptors, number of atoms, number of rotatable bonds etc. and 

also predict bioactivity score of ligands 
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The molecular structure of the designed ligands was drawn using online 

Molinspiration software (www.molinspiration.com)for calculation of molecular properties. 

The calculated value of the drug likeliness score and various parameters of all designed 

ligands were given in Table.no.6 and the bioactivity scores are shown in Figure.no.14. 

 

b. ADMET Properties 

Osiris Property explorer 

Osiris Property explorer is an online cheminformatics tool employed to determine 

toxicity potential of designed molecular compounds. The virtual toxicity results are colour 

coded either in green or red.  

 Toxicity properties shown in green indicates the molecule are safe and non-toxic  

 Toxicity properties shown in red indicate the molecule are toxic and have undesired 

effects (Tumorogenicity, Mutagenicity, Irritant effect and Reproductive effect).  

The in silico toxicity of the designed compounds were determined by sketching the structures 

in online tool and the results are illustrated in Figure.no.15. 

http://www.cheminfo.org/Chemistry/Cheminformatics/Property_explorer/index.html# 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.molinspiration.com/
http://www.cheminfo.org/Chemistry/Cheminformatics/Property_explorer/index.html
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V.A. II. RESULTS AND DISCUSSION 

2. Virtual Scaffold Library of newly designed ligands as PCSK9 Inhibitors 

 

Figure.no.12:2D structure of newly designed ligands 
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Figure.no.12:2D structure of newly designed ligands 
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Figure.no.12:2D structure of newly designed ligands 
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Figure.no.12:2D structure of newly designed ligands 
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Figure.no.12: 2D structure of newly designed ligands 
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Figure.no.12: 2D structure of newly designed leads 
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3. DOCKING STUDIES 

Docking studies was performed on all the newly designed 150 PCSK9 inhibitors 

retrieved from virtual screening using Autodock4.2.6 to identify which ligand interacts better 

with the target protein. The bonding interactions of the selected molecules at the active sites 

of PCSK9 inhibitors was also determined. Results of predicted activity of all the designed 

ligands with fitness score are given below in Table.no.4. 

Table.no.4: Docking score for designed ligands 

 

 

S.NO 

 

LIGAND 

 

DOCKING SCORE (kcal/mol) 

 

1 

 

Lig 1 

 

-8.48. 

 

2 

 

Lig 2 

 

-8.73 

 

3 

 

Lig 3 

 

-9.12 

 

4 

 

Lig 4 

 

-8.05 

 

5 

 

Lig 5 

 

-8.86 

 

6 

 

Lig6 

 

-8.26 

 

7 

 

Lig 7 

 

-10.24 

 

8 

 

Lig 8 

 

-8.53 

 

9 

 

Lig 9 

 

-8.43 

 

10 

 

Lig 10 

 

-8.98 

 

11 

 

Lig 11 

 

-7.98 

 

12 

 

Lig 12 

 

-8.78 

 

13 

 

Lig 13 

 

-8.01 
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14 

 

Lig 14 

 

-8.23 

 

15 

 

Lig 15 

 

-10.96 

 

16 

 

Lig 16 

 

-9.04 

 

17 

 

Lig 17 

 

-9.58 

 

18 

 

Lig 18 

 

-9.52 

 

19 

 

Lig 19 

 

-8.61 

 

 

20 

 

Lig 20 

 

-8.54 

 

 

21 

 

Lig 21 

 

-9.64 

 

22 

 

Lig 22 

 

-8.74 

 

    23 

 

Lig 23 

 

-8.61 

 

24 

 

Lig 24 

 

-8.28 

 

25 

 

Lig 25 

 

-9.34 

 

26 

 

Lig 26 

 

-7.78 

 

27 

 

Lig 27 

 

-6.75 

 

28 

 

Lig 28 

 

-8.8 

 

29 

 

Lig 29 

 

-7.49 

 

30 

 

Lig 30 

 

-9.15 

 

31 

 

Lig 31 

 

-8.88 

 

32 

 

Lig32 

 

-8.96 
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33 

 

Lig 33 

 

-8.53 

 

34 

 

Lig 34 

 

-10.24 

 

35 

 

Lig 35 

 

-9.37 

 

36 

 

Lig 36 

 

-9.06 

 

37 

 

Lig 37 

 

-8.49 

 

38 

 

Lig 38 

 

-8.36 

 

39 

 

Lig 39 

 

-9.06 

 

40 

 

Lig 40 

 

-7.25 

 

41 

 

Lig41 

 

-8.18 

 

42 

 

Lig42 

 

-7.26 

 

43 

 

Lig43 

 

-6,68 

 

44 

 

Lig44 

 

-8.77 

 

45 

 

Lig45 

 

-8,42 

 

46 

 

Lig 46 

 

-8.34 

 

47 

 

Lig 47 

 

-7.66 

 

48 

 

Lig 48 

 

-8.18 

 

49 

 

Lig 49 

 

-10.05 

 

50 

 

Lig 50 

 

-10.19 

 

51 

 

Lig 51 

 

-8.25 
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52 

 

Lig 52 

 

-8.59 

 

53 

 

Lig 53 

 

-8.14 

 

54 

 

Lig 54 

 

-8.80 

 

55 

 

Lig 55 

 

-8.88 

 

56 

 

Lig 56 

 

-9.16 

 

57 

 

Lig 57 

 

-9.16 

 

58 

 

Lig 59 

 

-5.8 

 

59 

 

Lig 59 

 

-8.25 

 

60 

 

Lig 60 

 

-8.29 

 

61 

 

Lig 61 

 

-7.95 

 

62 

 

Lig 62 

 

-8.83 

 

63 

 

Lig 63 

 

-6.17 

 

64 

 

Lig 64 

 

-8.68 

 

65 

 

Lig 65 

 

-9.30 

 

66 

 

Lig 66 

 

-8.04 

 

67 

 

Lig 67 

 

-5.39 

 

68 

 

Lig 68 

 

-8.23 

 

69 

 

Lig 69 

 

-8.67 

 

70 

 

Lig 70 

 

-7.74 
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71 

 

Lig 71 

 

-8.18 

 

72 

 

Lig 72 

 

-8.58 

 

73 

 

Lig 73 

 

-6.80 

 

74 

 

Lig 74 

 

-7.90 

 

75 

 

Lig 75 

 

-7.73 

 

76 

 

Lig 76 

 

-9.05 

 

77 

 

Lig 77 

 

-8.23 

 

78 

 

Lig 78 

 

-8.72 

 

79 

 

Lig 79 

 

-7.87 

 

80 

 

Lig 80 

 

-7.42 

 

81 

 

Lig 81 

 

-8.94 

 

82 

 

Lig 82 

 

-7.75 

 

83 

 

Lig 83 

 

-8.37 

 

84 

 

Lig 84 

 

-7.01 

 

85 

 

Lig 85 

 

-7.44 

 

86 

 

Lig 86 

 

-8.72 

 

87 

 

Lig 87 

 

-7.68 

 

88 

 

Lig 88 

 

-9.49 

 

89 

 

Lig 89 

 

-8.16 
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90 

 

Lig 90 

 

-8.35 

 

91 

 

Lig 91 

 

-9.79 

 

92 

 

Lig 92 

 

-8.23 

 

93 

 

Lig 93 

 

-9.42 

 

94 

 

Lig 94 

 

-8.93 

 

95 

 

Lig 95 

 

-7.99 

 

96 

 

Lig 96 

 

-8.79 

 

97 

 

Lig 97 

 

-9.17 

 

98 

 

Lig 98 

 

-8.87 

 

99 

 

Lig 99 

 

-8.20 

 

100 

 

Lig 100 

 

-8.59 

 

101 

 

Lig 101 

 

-9.54 

 

102 

 

Lig 102 

 

-8.79 

 

103 

 

Lig 103 

 

-10.37 

 

104 

 

Lig 104 

 

-7.26 

 

105 

 

Lig105 

 

-9.18 

 

106 

 

Lig 106 

 

-7.54 

 

107 

 

Lig 107 

 

-7.82 

 

108 

 

Lig 108 

 

-8.11 
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109 

 

Lig 109 

 

-8.14 

 

110 

 

Lig 110 

 

-7.73 

 

111 
 

Lig 111 
 

-8.43 

 

112 
 

Lig 112 
 

-7.90 

 

113 
 

Lig 113 
 

-7.07 

 

114 
 

Lig 114 
 

-7.59 

 

115 
 

Lig 115 
 

-7.60 

 

116 

 

Lig 116 

 

-8.04 

 

117 
 

Lig 117 
 

-7.21 

 

118 
 

Lig 118 
 

-8.19 

 

119 
 

Lig 119 
 

-8.74 

 

120 
 

Lig 120 
 

-8.15 

 

121 

 

Lig 121 

 

-6.90 

 

122 

 

Lig 122 

 

-7.52 

 

123 

 

Lig 123 

 

-7.41 

 

124 

 

Lig 124 

 

-8.42 

 

125 

 

Lig 125 

 

-8.19 

 

126 

 

Lig 126 

 

-8.03 

 

127 

 

Lig 127 

 

-8.30 
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128 

 

Lig 128 

 

-7.95 

 

129 

 

Lig 129 

 

-8.03 

 

130 

 

Lig 130 

 

-9.15 

 

131 

 

Lig 131 

 

-9.67 

 

132 

 

Lig 132 

 

-6.10 

 

133 

 

Lig 133 

 

-6.69 

 

134 

 

Lig 134 

 

-8.06 

 

135 

 

Lig 135 

 

-7.44 

 

136 

 

Lig 136 

 

-7.01 

 

137 

 

Lig 137 

 

-9.76 

 

138 

 

Lig 138 

 

-6.80 

 

139 

 

Lig 139 

 

-8.44 

 

140 

 

Lig 140 

 

-6.96 

 

141 

 

Lig 141 

 

-6.32 

 

142 

 

Lig 142 

 

-6.88 

 

143 

 

Lig 143 

 

-9.04 

 

144 

 

Lig 144 

 

-8.33 

 

145 

 

Lig 145 

 

-8.87 

 

146 

 

Lig 146 

 

-7.80 
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147 

 

Lig 147 

 

-8.15 

 

148 

 

Lig 148 

 

-8.19 

 

149 

 

Lig 149 

 

-9.67 

 

150 

 

Lig 150 

 

-9.36 

 

Based on the docking results, all the 150 newly designed ligands were categorized as 

highly active, moderately active and low active hits. 

Table 5: Docking results of PCSK9 inhibitors using Autodock4.2.6 

Receptor Highly active 

(>10) 

Moderately active 

(8-10) 

Low active 

(<8) 

 

 

 

 

PCSK9 

Inhibitors 

Lig7, Lig15,Lig34, 

Lig49,Lig73 

 

Lig1-6, Lig8, Lig10 

Lig12, Lig13, 

Lig14,Lig16-

25,Lig28,Lig30-33 

Lig35-39,Lig41,Lig44-

46,Lig48,Lig50,Lig59,Lig

60, Lig62,Lig64-66,Lig68, 

Lig71,Lig72, Lig76-78, 

Lig81, Lig83, Lig84, 

Lig86, Lig88-94, Lig96-

102, Lig105, Lig108, 

Lig109, Lig111, Lig116, 

Lig118-120, Lig124-127, 

Lig129, Lig131, Lig134-

135, Lig139, Lig143-145, 

Lig147-150. 

Lig26-

27,Lig29,Lig40,Lig42-

43,Lig47,Lig58, Lig61, 

Lig63, Lig67, Lig70, 

Lig73-75, Lig79, Lig80, 

Lig82, Lig85, Lig87, 

Lig95, Lig104, Lig106, 

Lig107, Lig110, Lig112-

115, Lig117, Lig121-123, 

Lig128, Lig132, Lig133, 

Lig135-137, Lig140, 

Lig141, Lig142, Lig146 
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Lig 1 Lig 3 

  
Lig 5 Lig 7 

  
Lig 8 Lig 10 

  
Lig 11 Lig 12 

Figure.no.13: Docking interactions of ligands 
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Lig 13 Lig 14 

  
Lig 15 Lig 16 

  
Lig 17 Lig 18 

  
Lig 19 Lig 20 

 

Figure.no.13: Docking interactions of ligands 
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Lig 21 Lig 22 

  
Lig 23 Lig 25 

  
Lig 28 Lig 30 

  
Lig 31 Lig 33 

 

Figure.no.13: Docking interactions of ligands 
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Lig 34 Lig 35 

  
Lig 36 Lig 39 

  
Lig 44 Lig 49 

  
Lig 50 Lig 52 

 

Figure.no.13: Docking interactions of ligands 
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Lig 54 Lig 56 

  
Lig 57 Lig 62 

  
Lig 64 Lig 65 

  
Lig 73 Lig 76 

 

Figure.no.13: Docking interactions of ligands 
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Lig 77 Lig 78 

  
Lig 81 Lig 86 

  
Lig 88 Lig 91 

  
Lig 93 Lig 94 

 

Figure.no.13: Docking interactions of ligands 
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Lig 96 Lig 97 

  
Lig 98 Lig 100 

  
Lig 101 Lig 102 

  
Lig 103 Lig 105 

Figure.no.13: Docking interactions of ligands 
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Lig 119 Lig 130 

  
Lig 131 Lig 137 

  
Lig 143 Lig 145 

  
Lig 149 Lig 150 

 

Figure.no.13: Docking interactions of ligands 
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4. Drug likeliness properties 

When all the newly designed 150 ligands of PCSK9 inhibitors were subjected to drug 

likeliness prediction studies Lipinski rule of five, ADMET like all were found to exhibit the 

drug likeliness properties 

Lipinski rule of five 

The Lipinski rule of five was performed using Molinspiration Online tool. All the newly 

designed PCSK9 ligands were found to pass Lipinski’s rule of five and the results were 

tabulated below. 

Table.no.6: Drug likeliness reports for PCSK9 inhibitors using Molinspiration Online 

tool 

 

 

 

Ligands 

 

 

Mol.Wt 

 

 

Log P 

 

 

nOHNH 

 

 

nON 

 

 

TPSA 

 

 

nrotb 

 

n- 

Violations 

 

Lig 1 

 

292.30 

 

1.92 

 

4 

 

7 

 

108.80 

 

2 

 

0 

 

Lig 2 

 

293.29 

 

2.58 

 

3 

 

7 

 

103.00 

 

2 

 

0 

 

Lig 3 

 

291.31 

 

3.29 

 

2 

 

6 

 

82.77 

 

2 

 

0 

 

Lig 4 

 

368.40 

 

3.84 

 

4 

 

7 

 

108.80 

 

3 

 

0 

 

Lig 5 

 

369.38 

 

4.28 

 

3 

 

7 

 

103.00 

 

    3 

 

0 

 

Lig 6 

 

306.33 

 

2.50 

 

4 

 

7 

 

108.80 

 

2 

 

0 
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Lig 7 

 

292.30 

 

2.79 

 

       2 

 

6 

 

90.98 

 

2 

 

0 

 

Lig 8 

 

293.28 

 

3.45 

 

1 

 

6 

 

85.18 

 

2 

 

0 

 

Lig 9 

 

291.31 

 

4.16 

 

0 

 

5 

 

64.96 

 

2 

 

0 

 

Lig 10 

 

292.30 

 

3.15 

 

3 

 

6 

 

90.98 

 

2 

 

0 

 

Lig 11 

 

355.35 

 

4.93 

 

1 

 

6 

 

85.18 

 

3 

 

0 

 

Lig 12 

 

291.31 

 

3.06 

 

2 

 

6 

 

82.77 

 

2 

 

0 

 

Lig 13 

 

305.34 

 

3.51 

 

2 

 

6 

 

82.77 

 

2 

 

0 

 

Lig 14 

 

353.38 

 

4.76 

 

2 

 

6 

 

82.77 

 

3 

 

0 

 

Lig 15 

 

369.38 

 

4.50 

 

3 

 

7 

 

103.00 

 

3 

 

0 

 

Lig 16 

 

263.26 

 

3.49 

 

0 

 

5 

 

64.96 

 

2 

 

0 

 

Lig 17 

 

296.29 

 

0.74 

 

5 

 

7 

 

121.10 

 

3 

 

0 

 

Lig 18 

 

278.27 

 

2.93 

 

2 

 

6 

 

90.98 

 

2 

 

0 

 

Lig 19 

 

277.28 

 

3.94 

 

0 

 

5 

 

64.96 

 

2 

 

0 
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Lig 20 

 

297.70 

 

4.17 

 

0 

 

5 

 

64.96 

 

2 

 

0 

 

Lig 21 

 

279.25 

 

3.23 

 

1 

 

6 

 

85.18 

 

2 

 

0 

 

Lig 22 

 

307.31 

 

2.59 

 

3 

 

7 

 

103.00 

 

2 

 

0 

 

Lig 23 

 

325.76 

 

3.74 

 

2 

 

6 

 

82.77 

 

2 

 

0 

 

Lig 24 

 

277.28 

 

3.71 

 

0 

 

5 

 

64.96 

 

2 

 

0 

 

Lig 25 

 

311.73 

 

4.39 

 

0 

 

5 

 

64.96 

 

2 

 

0 

 

Lig 26 

 

318.38 

 

4.23 

 

2 

 

5 

 

66.91 

 

4 

 

0 

 

Lig 27 

 

186.21 

 

1.98 

 

2 

 

3 

 

44.89 

 

2 

 

0 

 

Lig 28 

 

327.77 

 

3.48 

 

2 

 

5 

 

74.85 

 

4 

 

0 

 

Lig 29 

 

309.32 

 

2.32 

 

3 

 

6 

 

95.08 

 

4 

 

0 

 

Lig 30 

 

308.34 

 

1.88 

 

4 

 

6 

 

100.88 

 

4 

 

0 

 

Lig 31 

 

296.29 

 

0.74 

 

5 

 

7 

 

121.10 

 

3 

 

0 

 

Lig32 

 

326.38 

 

2.21 

 

2 

 

5 

 

79.29 

 

4 

 

0 
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Lig 33 

 

337.38 

 

2.08 

 

2 

 

6 

 

84.22 

 

5 

 

0 

 

Lig 34 

 

310.31 

 

2.76 

 

2 

 

6 

 

92.43 

 

4 

 

0 

 

Lig 35 

 

215.25 

 

1.73 

 

1 

 

3 

 

50.19 

 

3 

 

0 

 

Lig 36 

 

352.39 

 

1.33 

 

3 

 

7 

 

94.03 

 

5 

 

0 

 

Lig 37 

 

230.27 

 

0.25 

 

2 

 

4 

 

62.22 

 

3 

 

0 

 

Lig 38 

 

231.25 

 

-0.12 

 

2 

 

5 

 

75.11 

 

3 

 

0 

 

Lig 39 

 

233.27 

 

1.26 

 

2 

 

4 

 

58.56 

 

3 

 

0 

 

Lig 40 

 

232.28 

 

0.88 

 

3 

 

4 

 

61.35 

 

3 

 

0 

 

Lig 41 

 

250.32 

 

0.70 

 

2 

 

4 

 

61.69 

 

3 

 

0 

 

Lig 42 

 

338.44 

 

1.89 

 

2 

 

5 

 

81.77 

 

6 

 

0 

 

Lig 43 

 

307.35 

 

1.60 

 

2 

 

5 

 

82.02 

 

5 

 

0 

 

Lig 44 

 

292.34 

 

1.27 

 

3 

 

5 

 

84.67 

 

5 

 

0 

 

Lig 45 

 

261.28 

 

1.75 

 

3 

 

6 

 

83.22 

 

4 

 

0 
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Lig 46 

 

262.26 

 

1.86 

 

2 

 

6 

 

80.57 

 

4 

 

0 

 

Lig 47 

 

262.27 

 

0.89 

 

3 

 

7 

 

96.11 

 

4 

 

0 

 

Lig 48 

 

279.32 

 

1.46 

 

2 

 

6 

 

80.32 

 

4 

 

0 

 

Lig 49 

 

247.25 

 

1.05 

 

2 

 

6 

 

84.23 

 

3 

 

0 

 

Lig 50 

 

305.34 

 

3.51 

 

2 

 

6 

 

82.77 

 

2 

 

0 

 

Lig 51 

 

219.24 

 

1.10 

 

4 

 

5 

 

77.14 

 

2 

 

0 

 

Lig 52 

 

303.39 

 

3.38 

 

2 

 

5 

 

71.09 

 

5 

 

0 

 

Lig 53 

 

279.37 

 

0.65 

 

3 

 

5 

 

76.72 

 

5 

 

0 

 

Lig 54 

 

273.29 

 

2.18 

 

2 

 

6 

 

84.23 

 

4 

 

0 

 

Lig 55 

 

272.31 

 

2.08 

 

3 

 

6 

 

86.88 

 

4 

 

0 

 

Lig 56 

 

287.32 

 

2.51 

 

3 

 

6 

 

 

83.22 

 

5 

 

0 

 

Lig 57 

 

288.37 

 

3.55 

 

2 

 

4 

 

58.20 

 

4 

 

0 
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Lig 59 270.33 2.37 2 4 58.20 4 0 

 

Lig 59 

 

216.24 

 

1.16 

 

2 

 

4 

 

61.96 

 

2 

 

0 

 

Lig 60 

 

232.24 

 

1.13 

 

3 

 

6 

 

86.88 

 

2 

 

0 

 

Lig 61 

 

243.27 

 

1.47 

 

2 

 

5 

 

71.09 

 

2 

 

0 

 

Lig 62 

 

231.25 

 

1.47 

 

3 

 

5 

 

73.99 

 

2 

 

0 

 

Lig 63 

 

232.24 

 

1.57 

 

2 

 

5 

 

71.34 

 

2 

 

0 

 

Lig 64 

 

262.33 

 

1.96 

 

2 

 

4 

 

58.20 

 

2 

 

0 

 

Lig 65 

 

248.31 

 

2.21 

 

2 

 

4 

 

58.20 

 

2 

 

0 

 

Lig 66 

 

270.33 

 

3.23 

 

2 

 

4 

 

61.96 

 

5 

 

0 

 

Lig 67 

 

260.30 

 

0.78 

 

4 

 

6 

 

93.04 

 

5 

 

0 

 

Lig 68 

 

275.33 

 

1.50 

 

3 

 

5 

 

85.08 

 

4 

 

0 

 

Lig 69 

 

273.29 

 

1.92 

 

3 

 

6 

 

98.22 

 

5 

 

0 

 

Lig 70 

 

288.31 

 

0.89 

 

4 

 

7 

 

110.11 

 

6 

 

0 
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Lig 71 

 

285.35 

 

2.06 

 

4 

 

5 

 

87.98 

 

6 

 

0 

 

Lig 72 

 

302.33 

 

2.25 

 

3 

 

6 

 

94.57 

 

7 

 

0 

 

Lig 73 

 

304.37 

 

2.39 

 

3 

 

5 

 

81.43 

 

6 

 

0 

 

Lig 74 

 

257.29 

 

0.99 

 

4 

 

5 

 

87.98 

 

4 

 

0 

 

Lig 75 

 

258.28 

 

1.10 

 

3 

 

5 

 

85.33 

 

4 

 

0 

 

Lig 76 

 

288.37 

 

2.24 

 

3 

 

4 

 

72.19 

 

5 

 

0 

 

Lig 77 

 

245.28 

 

0.43 

 

5 

 

5 

 

91.14 

 

4 

 

0 

 

Lig 78 

 

246.27 

 

0.77 

 

4 

 

6 

 

86.01 

 

2 

 

0 

 

Lig 79 

 

232.24 

 

1.67 

 

2 

 

5 

 

75.36 

 

3 

 

0 

 

Lig 80 

 

246.27 

 

2.21 

 

1 

 

5 

 

64.36 

 

4 

 

0 

 

Lig 81 

 

301.30 

 

1.19 

 

2 

 

7 

 

101.30 

 

5 

 

0 

 

Lig 82 

 

273.29 

 

1.74 

 

2 

 

6 

 

84.23 

 

5 

 

0 

 

Lig 83 

 

257.29 

 

2.06 

 

3 

 

5 

 

73.99 

 

3 

 

0 
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Lig 84 

 

245.28 

 

1.50 

 

4 

 

5 

 

77.14 

 

3 

 

0 

 

Lig 85 

 

231.25 

 

1.68 

 

4 

 

5 

 

77.14 

 

2 

 

0 

 

Lig 86 

 

256.31 

 

2.36 

 

2 

 

4 

 

61.96 

 

4 

 

0 

 

Lig 87 

 

258.32 

 

3.56 

 

2 

 

4 

 

54.12 

 

6 

 

0 

 

Lig 88 

 

278.33 

 

2.50 

 

2 

 

5 

 

67.43 

 

4 

 

0 

 

Lig 89 

 

261.28 

 

1.75 

 

3 

 

6 

 

83.22 

 

4 

 

0 

 

Lig 90 

 

262.26 

 

1.86 

 

2 

 

6 

 

80.57 

 

4 

 

0 

 

Lig 91 

 

262.27 

 

0.89 

 

3 

 

7 

 

96.11 

 

4 

 

0 

 

Lig 92 

 

279.32 

 

1.46 

 

2 

 

6 

 

80.32 

 

4 

 

0 

 

Lig 93 

 

247.25 

 

1.05 

 

2 

 

6 

 

84.23 

 

3 

 

0 

 

Lig 94 

 

265.27 

 

1.22 

 

3 

 

7 

 

88.69 

 

4 

 

0 

 

Lig 95 

 

220.27 

 

1.55 

 

2 

 

4 

 

58.20 

 

4 

 

0 

 

Lig 96 

 

235.31 

 

2.39 

 

3 

 

4 

 

68.01 

 

2 

 

0 
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Lig 97 

 

279.34 

 

3.67 

 

1 

 

4 

 

46.92 

 

3 

 

0 

 

Lig 98 

 

282.37 

 

4.35 

 

1 

 

3 

 

41.99 

 

3 

 

0 

 

Lig 99 

 

266.30 

 

3.71 

 

1 

 

4 

 

55.13 

 

3 

 

0 

 

Lig 100 

 

261.28 

 

1.52 

 

2 

 

6 

 

79.79 

 

4 

 

0 

 

Lig 101 

 

326.38 

 

2.21 

 

2 

 

5 

 

79.29 

 

4 

 

0 

 

Lig 102 

 

337.38 

 

2.08 

 

2 

 

6 

 

84.22 

 

5 

 

0 

 

Lig 103 

 

310.31 

 

2.76 

 

2 

 

6 

 

92.43 

 

4 

 

0 

 

Lig 104 

 

215.25 

 

1.73 

 

1 

 

3 

 

50.19 

 

3 

 

0 

 

Lig 105 

 

352.39 

 

1.33 

 

3 

 

7 

 

94.03 

 

5 

 

0 

 

Lig 106 

 

230.27 

 

0.25 

 

2 

 

4 

 

62.22 

 

3 

 

0 

 

Lig 107 

 

231.25 

 

-0.12 

 

2 

 

5 

 

75.11 

 

3 

 

0 

 

Lig 108 

 

233.27 

 

1.26 

 

2 

 

4 

 

58.56 

 

3 

 

0 

 

Lig 109 

 

232.28 

 

0.88 

 

3 

 

4 

 

61.35 

 

3 

 

0 
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Lig 110 

 

250.32 

 

0.70 

 

2 

 

4 

 

61.69 

 

3 

 

0 

 

Lig 111 

 

219.24 

 

-0.23 

 

3 

 

5 

 

78.01 

 

3 

 

0 

 

Lig 112 

 

220.23 

 

0.20 

 

2 

 

5 

 

75.36 

 

3 

 

0 

 

Lig 113 

 

236.30 

 

0.34 

 

2 

 

4 

 

62.22 

 

3 

 

0 

 

Lig 114 

 

222.27 

 

1.03 

 

2 

 

4 

 

62.22 

 

2 

 

0 

 

Lig 115 

 

248.31 

 

0.90 

 

1 

 

4 

 

59.06 

 

3 

 

0 

 

Lig 116 

 

246.31 

 

0.07 

 

5 

 

5 

 

85.67 

 

4 

 

0 

 

Lig 117 

 

245.33 

 

2.29 

 

4 

 

4 

 

73.64 

 

4 

 

0 

 

Lig 118 

 

262.31 

 

-0.75 

 

5 

 

6 

 

94.91 

 

5 

 

0 

 

Lig 119 

 

277.39 

 

1.79 

 

3 

 

4 

 

59.65 

 

5 

 

0 

 

Lig 120 

 

256.35 

 

3.58 

 

3 

 

3 

 

47.28 

 

5 

 

0 

 

Lig 121 

 

231.25 

 

1.45 

 

4 

 

5 

 

80.15 

 

4 

 

0 

 

Lig 122 

 

214.27 

 

1.15 

 

3 

 

3 

 

55.12 

 

3 

 

0 
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Lig 123 

 

232.31 

 

2.04 

 

3 

 

3 

 

   55.12 

 

3 

 

0 

 

Lig 124 

 

243.31 

 

2.13 

 

4 

 

4 

 

70.91 

 

4 

 

0 

 

Lig 125 

 

217.23 

 

0.66 

 

3 

 

5 

 

81.15 

 

3 

 

0 

 

Lig 126 

 

247.26 

 

-0.77 

 

4 

 

7 

 

105.93 

 

4 

 

0 

 

Lig 127 

 

262.34 

 

-0.50 

 

3 

 

5 

 

80.91 

 

4 

 

0 

 

Lig 128 

 

261.29 

 

-0.99 

 

3 

 

7 

 

106.94 

 

5 

 

0 

 

Lig 129 

 

276.32 

 

0.50 

 

1 

 

6 

 

84.84 

 

4 

 

0 

 

Lig 130 

 

329.38 

 

2.10 

 

3 

 

6 

 

87.24 

 

4 

 

0 

 

Lig 131 

 

313.31 

 

1.46 

 

3 

 

7 

 

100.38 

 

4 

 

0 

 

Lig 132 

 

312.33 

 

1.11 

 

4 

 

7 

 

103.03 

 

4 

 

0 

 

Lig 133 

 

311.34 

 

1.89 

 

4 

 

6 

 

90.14 

 

4 

 

0 

 

Lig 134 

 

294.35 

 

2.80 

 

3 

 

4 

 

65.12 

 

3 

 

0 

 

Lig 135 

 

328.39 

 

2.63 

 

3 

 

5 

 

74.35 

 

4 

 

0 
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Lig 136 

 

  330.37 

 

2.70 

 

2 

 

6 

 

84.59 

 

4 

 

0 

 

Lig 137 

 

297.31 

 

1.60 

 

3 

 

6 

 

91.15 

 

3 

 

0 

 

Lig 138 

 

296.33 

 

1.75 

 

4 

 

6 

 

93.80 

 

3 

 

0 

 

Lig 139 

 

313.38 

 

2.49 

 

3 

 

5 

 

78.01 

 

3 

 

0 

 

Lig 140 

 

312.39 

 

3.03 

 

3 

 

4 

 

65.12 

 

3 

 

0 

 

Lig 141 

 

219.31 

 

2.55 

 

2 

 

2 

 

35.26 

 

2 

 

0 

 

Lig 142 

 

322.33 

 

0.50 

 

3 

 

8 

 

112.66 

 

4 

 

0 

 

Lig 143 

 

293.37 

 

3.10 

 

4 

 

4 

 

70.91 

 

4 

 

0 

 

Lig 144 

 

268.32 

 

3.58 

 

3 

 

4 

 

61.04 

 

3 

 

0 

 

Lig 145 

 

293.33 

 

1.21 

 

3 

 

5 

 

88.85 

 

4 

 

0 

 

Lig 146 

 

293.33 

 

0.53 

 

3 

 

6 

 

97.56 

 

5 

 

0 

 

Lig 147 

 

294.31 

 

0.96 

 

2 

 

6 

 

94.91 

 

5 

 

0 

 

Lig 148 

 

338.44 

 

1.89 

 

2 

 

5 

 

81.77 

 

6 

 

0 
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Lig 149 

 

307.35 

 

1.60 

 

2 

 

5 

 

82.02 

 

5 

 

0 

 

Lig 150 

 

292.34 

 

1.27 

 

3 

 

5 

 

84.67 

 

5 

 

0 
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Lig1 Lig 3 

Lig 5 Lig 7 

Lig 8 Lig 10 

Lig 11 Lig 12 

 

Figure.no.14: Biological properties of selected PCSK9 inhibitors 
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Lig13 Lig 14 

Lig 15 Lig 16 

Lig 17 Lig 18 

Lig 19 Lig 20 

 

Figure.no.14: Biological properties of selected PCSK9 inhibitors 
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Lig 21 Lig 22 

Lig 23 Lig 25 

Lig 28 Lig 30 

Lig 31 Lig 33 

 

Figure.no.14: Biological properties of selected PCSK9 inhibitors 
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Lig 34 Lig 35 

Lig 36 Lig 39 

Lig 44 Lig 49 

Lig 50 Lig 52 

 

Figure.no.14: Biological properties of selected PCSK9 inhibitors 
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Lig 54 Lig 56 

Lig 57 Lig 62 

Lig 64 Lig 65 

Lig 73 Lig 76 

 

Figure.no.14: Biological properties of selected PCSK9 inhibitors 
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Lig 77 Lig 78 

Lig 81 Lig 86 

Lig 88 Lig 91 

Lig 93 Lig 94 

 

Figure.no.14: Biological properties of selected PCSK9 inhibitors 
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Lig 96 Lig 97 

Lig 98 Lig 100 

Lig 101 Lig 102 

Lig 103 Lig 105 

 

Figure.no.14: Biological properties of selected PCSK9 inhibitors 
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Lig119 Lig 130 

Lig 131 Lig 137 

Lig 143 Lig 145 

Lig 149 Lig 150 

 

  Figure.no.14: Biological properties of selected PCSK9 inhibitors 
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Lig 1 Lig 3 

Lig 5 Lig 7 

Lig 8 Lig 10 

Lig 11 Lig 12 

Figure.no.15: Toxicity profile of selected PCSK9 inhibitors 
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Lig 13 Lig 14 

Lig 15 Lig 16 

Lig 17 Lig 18 

Lig 19 Lig 20 

Figure.no.15: Toxicity profile of selected PCSK9 inhibitors 
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Lig 21 Lig 22 

Lig 23 Lig 25 

Lig 28 Lig 30 

Lig 31 Lig 33 

Figure.no.15: Toxicity profile of selected PCSK9 inhibitors 
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Lig 34 Lig 35 

Lig 36 Lig 39 

Lig 44 Lig 49 

Lig 50 Lig 52 

Figure.no.15: Toxicity profile of selected PCSK9 inhibitors 
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Lig 54 Lig 56 

Lig 57 Lig 62 

Lig 64 Lig 65 

Lig 73 Lig 76 

Figure.no.15: Toxicity profile of selected PCSK9 inhibitors 
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Lig 77 Lig 78 

Lig 81 Lig 86 

Lig 88 Lig 91 

Lig 93 Lig 94 

Figure.no.15: Toxicity profile of selected PCSK9 inhibitors 
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Lig 96 Lig 97 

Lig 98 Lig 100 

Lig 101 Lig 102 

Lig 103 Lig 105 

Figure.no.15: Toxicity profile of selected PCSK9 inhibitors 
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Lig119 Lig 130 

Lig 131 Lig 137 

Lig 143 Lig 145 

Lig 149 Lig 150 

Figure.no.15: Toxicity profile of selected PCSK9 inhibitors 
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 Thus the proposed ligands like ligand 7, ligand 8, ligand 10, ligand 12, and ligand 

13 for synthesis have satisfied all the above filtering method of good predictive activity with 

good docking scores and also drug likeliness properties confirming that these molecules are 

accepted to be orally bioavailable.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



EXPERIMENTAL WORK 

Department of Pharmaceutical Chemistry, COP, MMC. Page 87 

V. B. SYHTHESIS AND CHARECTERIZATION 

MATERIALS AND METHODS 

V.B.1. SYNTHESIS 

The ligands with top docking score and synthetic feasibility were selected for 

synthesis. All reagents and solvents used were of analytical grade.  

Chemicals used for synthesis 

 

PARA HYDROXY METHYL BENZOATE 

 

 

 

 

 

 

 

 

Molecular formula  : C7H7NO2 

Molecular weight  :  152.15g/mol 

Description  :  white crystalline powder 

Melting point  :  125-128
0
C 

Boiling point  : 275
0
C 
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PARA AMINO BENZOIC ACID 

 

 

 

 

 

 

 

 

Molecular formula  : C7H7NO2 

Molecular weight  :  137.14g/mol 

Description  :  white crystalline powder 

Melting point  :  187
0
C 

Boiling point  : 340
0
C 

 

 

SALICYLIC ACID 

 

 

 

 

 

 

 

 

 

Molecular formula  : C7H6O3 

Molecular weight  :  138.12g/mol 

Description  :  white to off-white crystalline poeder 

Melting point  :  159
0
C 

Boiling point  : 211
0
C 
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ANTHRANILIC ACID 

 

 

 

 

 

 

 

 

 

Molecular formula  : C7H7NO2 

Molecular weight  :  137.14g/mol 

Description  :  white solid 

Melting point  :  144-148
0
C 

Boiling point  : 200
0
C 

 

BENZOIC ACID 

 

 

 

 

 

 

 

 

 

Molecular formula  : C7H6O2 

Molecular weight  :  122.123g/mol 

Description  :  white solid 

Melting point  :  122
0
C 

Boiling point  : 250
0
C 
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TOLUIC ACID 

 

 

 

 

 

 

 

 

 

Molecular formula  : C8H8O2 

Molecular weight  :  136.15g/mol 

Description  :  white solid 

Melting point  :  180-181
0
C 

Boiling point  : 274-275
0
C 
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SYNTHETIC METHODOLOGY 

 

 

 

 

 

Figure.no.20: Scheme 
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Procedure 

STEP1: Synthesis of 4-Hydroxy-3-nitro-benzoic acid methyl ester (I): 

4- hydroxyl methyl benzoate (10g, 0.74 mol) was placed in a round bottomed flask 

equipped with reflux condenser and thermometer. A mixture of concentrated sulphuric acid 

(6.2 ml) and nitric acid (6.2 ml) was added drop wise in p- hydroxyl methyl benzoate with 

stirring. Cool the flask in ice bath to 0-10
0
C.  Then pour the reaction mixture into crushed ice. 

Filtered off the crude product m- nitro-p-hydroxy-methyl benzoate and washed with cold 

water. Transfer the solids into 500 ml flask and stirred it with ice cold methanol in order to 

remove a small amount of ortho isomer and other impurities. The mixture was filtered and 

recrystallized using ethanol as solvent. The purity of product was established by single spot-

on TLC. The percentage yield was found to be 85%. 

STEP2: Synthesis of 3- Amino-4-hydroxy-benzoic acid methyl ester (II): 

In a 500 ml three necked flask bottom flask equipped with reflux condenser with 

guard tube, compound I (10g) was dissolved in boiling alcohol (50%, 100 ml) and sodium 

dithionite was added to this boiling alcohol solution until it becomes almost colourless. Then 

the alcohol was reduced to one third of its volume by distillation and the residual liquid was 

triturated with ice cold water. The resulting product was filtered, washed with cold water, 

dried and recrystallized using ethanol as solvent. The purity of product was established by 

single spot-on TLC. The percentage yield was found to be 83% 

STEP3: Synthesis of 2- substituted benzoxazole-5-carboxylic acid methyl ester (III)  

Compound II (0.01 mol) was heated with an appropriate aliphatic acid in excess under 

reflux for 2 hours. The reaction mixture was poured in crushed ice with stirring. The product 

thus separated was filtered and washed with cold water. The products were recrystallized by 

using ethanol as solvent. The purity of product was established by single spot-on TLC. The 

percentage yield was found to be 86% 

STEP4: Synthesis of 2- substituted benzoxazole-5-carboxylic acid hydrazide (IV)  

A mixture of an appropriate 2- substitutedbenzoxazole-5-carboxylic acid methyl ester 

III (0.001 mol) in alcohol (25 ml) and hydrazine hydrate (99%, 0.015 mol) was heated under 

reflux on water bath for 4 hours. The alcohol was reduced to half of its volume and cooled. 
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The product separated was filtered and washed with small portions of cold alcohol and then 

with cold water repeatedly and dried. The resultant product was recrystallized using ethanol 

as solvent. The purity of product was established by single spot-on TLC. The percentage 

yield was found to be 74%. 

 

STEP5: Synthesis of 5-(5-phenyl-1,3,4 oxadiazol-2-yl)-benzo(d)oxazole derivatives (V) 

Compound IV (0.01 mol), aromatic acids (0.01 mol), Phosphorus oxychloride was 

refluxed for about 5-6 hrs. Then the mixture was made alkaline with sodium bicarbonate. The 

product was dried and recrystallized using ethanol. The purity of product was established by 

single spot-on TLC. 

 

STEP6: Synthesis of 3-(benzo(d)oxazol-5-yl-)-5-phenyl-4H-1,2,4 -triazole-4-amine 

derivatives (VI) 

Compound (V) (0.01 mol) was treated with hydrazine hydrate (0.015 mol) and 

refluxed for about 2 hrs in dry pyridine (15ml). Then neutralized with hydrochloric acid. The 

obtained corresponding amino triazoles were filtered, dried and recrystallized with ethanol. 

The purity of this product was established by single spot on the TLC. The purity of product 

was established by single spot-on TLC. 
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V.B.2. CHARECTERIZATION 

 

The purity of the synthesized compounds was checked by TLC method and 

observance of the sharp melting point. Progress of the reactions was monitored by thin layer 

chromatographic technique. TLC was performed using Aluminum plates pre-coated with 

Silica gel 60F 254 (E-Merck); the mobile phase used for all synthesized compound was 

Methanol: CHCl3 in the ratio of 9:1. Spots were detected using UV light chamber and Iodine 

chamber (Solvent system- methanol,). Melting points of all the synthesized compounds were 

determined by open-capillary tubes and values were uncorrected. All the synthesized 

compounds were characterized by the following instrumental methods. 

 

 IR spectroscopy by ABB MB3000-PH FT-IR Spectrometer 

 1
H-NMR spectroscopy by BRUKER Topspin Advance 400MHZ NMR Spectra using 

Deuterated DMSO 

 LC-MS spectrometry by Waters - Xevo G2- XS - QToF High Resolution Mass 

spectrometer 

 

IR SPECTROSCOPY 

IR spectroscopy (which is short for infrared spectroscopy) deals with the infrared 

region of the electromagnetic spectrum, i.e. light having a longer wavelength and a lower 

frequency than visible light. Infrared Spectroscopy generally refers to the analysis of the 

interaction of a molecule with infrared light. The major use of infrared spectroscopy is to 

determine the functional groups of molecules, relevant to both organic and inorganic 

chemistry. 

Regions of the Infrared spectrum 

Most of the bands that indicate what functional group is present are found in the 

region from 4000 cm-1to 1300 cm-1. Their bands can be identified and used to determine the 

functional group of an unknown compound. 

Bands that are unique to each molecule, similar to a fingerprint, are found in the 

fingerprint region, from 1300 cm-1 to 400 cm-1. These bands are only used to compare the 

spectra of one compound with another. 
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MASS SPECTROMETRY 

Mass spectrometry is an analytical technique used to establish the molecular structure 

and the molecular weight of the analyte under investigation. In this technique, the compound 

under investigation is bombarded with a beam of electrons producing ionic fragments of the 

original species. The relative abundance of the fragment ion formed depends on the stability 

of the ion and of the lost radical. The resulting charged particles are then separated according 

to their masses. Mass spectrum is a record of information regarding various masses produced 

and their relative abundances. 

 

HYPHENATED TECHNIQUES 

A technique where a separation technique is coupled with an online spectroscopic 

detection technology is known as hyphenated technique. Chromatography produces pure or 

nearly pure fractions of chemical components in a mixture. Spectroscopy produces selective 

information for identification using standards or library spectra. These hyphenated techniques 

offer shorter analysis time, higher degree of automation, higher sample throughput, better 

reproducibility, reduction of contamination because it is a closed system, enhanced combined 

selectivity and therefore higher degree of information. 

Various hyphenated techniques: 

 

 GC-MS 

 LC-MS 

 LC-FTIR 

 LC-NMR 

 CE-MS 

 

Liquid Chromatography–Mass Spectrometry (LC-MS) 

LC-MS is an analytical chemistry technique that combines the physical separation 

capabilities of liquid chromatography (or HPLC) with the mass analysis capabilities of mass 

spectrometry (MS). Coupled chromatography - MS systems are popular in chemical analysis 

because the individual capabilities of each technique are enhanced synergistically. While 

liquid chromatography separates mixtures with multiple components, mass spectrometry 

provides structural identity of the individual components with high molecular specificity and 

detection sensitivity.  
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RESULTS AND DISCUSSION 

 

Table.no.7: List of compounds synthesized 

Compound  

Code 

 

IUPAC Name 

 

Structure 

 

 

VD1 

 

4‐ [5‐ (2‐ methyl‐ 1,3‐
benzoxazol‐ 5‐ yl)‐ 1,3,4‐
oxadiazol‐ 2‐ yl]aniline 

 

 

 

 

VD2 

 

2‐ [5‐ (2‐ methyl‐ 1,3‐
benzoxazol‐ 5‐ yl)‐ 1,3,4‐
oxadiazol‐ 2‐ yl]phenol 

 

 

 

 

VD3 

 

2‐ [5‐ (2‐ methyl‐ 1,3‐
benzoxazol‐ 5‐ yl)‐ 1,3,4‐
oxadiazol‐ 2‐ yl]aniline 

 

 

 

 

VD4 

 

3‐ (2‐ methyl‐ 1,3‐
benzoxazol‐ 5‐ yl)‐ 5‐ phenyl‐
4H‐ 1,2,4‐ triazol‐ 4‐ amine 

 

 

 

 

VD5 

 

3‐ (2‐ methyl‐ 1,3‐
benzoxazol‐ 5‐ yl)‐ 5‐ (4‐
methylphenyl)‐ 4H‐ 1,2,4‐
triazol‐ 4‐ amine 
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PRODUCT PROFILE 

VD1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Molecular Formula :  C16H12N4O2 

Formula Weight :  292.29208 

Appearance               :  Yellow 

Melting Point                    : 172
0
C 

Rf Value                           : 0.73 

Yield                                 : 75.36% 

Composition                     :  C(65.75%) H(4.14%) N(19.17%)  

  O(10.95%) 

Molar refractivity             :  81.21 ± 0.3 cm
3
 

Molar volume                   :  217.9 ± 3.0 cm
3
 

Parachor :  611.7 ± 4.0 cm
3
 

Index of Refractivity :  1.667 ± 0.02  

Surface Tension :  62.0 ± 3.0 dyne/cm  

Polarizability :  32.19 ± 0.5 10
-24

cm
3
 

 

4‐ [5‐ (2‐ methyl‐ 1,3‐ benzoxazol‐ 5‐ yl)‐ 1,3,4‐ oxadiazol‐ 2‐ yl]aniline 
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INFRARED SPECTRUM OF VD1: 

 

 

Figure.no.17: IR Spectrum of Compound VD1 

 

Table.no.8: IR Interpretation of Compound VD1  

 

S.NO 

 

WAVE NUMBER (cm
-1

) 

 

FUNCTIONAL GROUPS 

 

1 

 

1681 

 

C=N Stretching 

 

2 

 

1596 

 

-C=C-  

 

3 

 

3317 

 

NH2 Stretching 

 

4 

 

2885 

 

SP2-C-H stretching 

 

5 

 

1234 

 

C-O-C Stretching 
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LC-MS SPECTRUM OF VD1: 

 

 

 

 

 

 

 

 

Figure.no.18: Chromatogram of Compound VD1 

 

 

 

 

 

 

 

 

 

 

 

Figure.no.19: Mass Spectrum of Compound VD1 
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PROTON NMR SPECTRUM OF VD1: 

 

 

 

 

 

 

 

 

 

 

 

 

Figure.no.20: 
1
H NMR Spectrum of Compound VD1 

Table.no.9: 
1
H NMR Interpretation of Compound VD1 

 

S.NO 

 

DELTA VALUE 

(PPM) 

 

NATURE OF 

PROTON 

 

NATURE OF 

PEAK 

 

NUMBER OF 

PROTONS 

 

1 

 

2.4 

 

Methyl C-H 

 

Singlet 

 

3 

 

2 

 

7.4-8.5 

 

Aromatic C-H 

 

Multiplet 

 

7 

 

3 

 

6.8 

 

NH2 

 

Singlet 

 

2 
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VD2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Molecular Formula :  C16H11N3O3 

Formula Weight :  293.27684 

Appearance               :  Yellow 

Melting Point                    : 177
0
C 

Rf Value                           : 0.77 

Yield                                 : 78.36% 

Composition                     :  C(65.53%) H(3.78%) N(14.33%)  

  O(16.37%) 

Molar refractivity             :  78.85 ± 0.3 cm
3
 

Molar volume                   :  214.0 ± 3.0 cm
3
 

Parachor :  600.8 ± 4.0 cm
3
 

Index of Refractivity :  1.658 ± 0.02  

Surface Tension :  62.0 ± 3.0 dyne/cm  

Polarizability :  31.26 ± 0.5 10
-24

cm
3
 

 

4‐ 2‐ [5‐ (2‐ methyl‐ 1,3‐ benzoxazol‐ 5‐ yl)‐ 1,3,4‐ oxadiazol‐  

2‐ yl]phenol 
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INFRARED SPECTRUM OF VD2: 

 

 

 

 

 

 

 

 

Figure.no.20: IR Spectrum of Compound VD2 

 

Table.no.10: IR Interpretation of Compound VD2  

 

S.NO 

 

WAVE NUMBER (cm
-1

) 

 

FUNCTIONAL GROUPS 

 

1 

 

1620 

 

C=N Stretching 

 

2 

 

1589 

 

-C=C- 

 

3 

 

3394 

 

OH Stretching 

 

4 

 

2815 

 

SP2-C-H Stretching 

 

5 

 

1288 

 

C-O-C Stretching 
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LC-MS SPECTRUM OF VD2: 

 

 

 

 

Figure.no.22: Chromatogram of Compound VD2 

 

 

 

 

 

 

Figure.no.23: Mass Spectrum of Compound VD2 
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PROTON NMR SPECTRUM OF VD2: 

 

 

 

 

 

 

 

 

 

Figure .no.24: 
1
H NMR Spectrum of Compound VD2 

 

 

 

Table.no.11: 
1
H NMR Interpretation of Compound VD2 

 

S.NO 

 

DELTA VALUE 

(PPM) 

 

NATURE OF 

PROTON 

 

NATURE OF 

PEAK 

 

NUMBER OF 

PROTONS 

 

1 

 

2.508 

 

Methyl C-H 

 

Singlet 

 

3 

 

2 

 

7.2-7.8 

 

Aromatic C-H 

 

Multiplet 

 

7 

 

3 

 

5.23 

 

Hydroxy-OH 

 

Singlet 

 

1 
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VD3 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Molecular Formula :  C16H12N4O2 

Formula Weight :  292.29208 

Appearance               :  Yellow 

Melting Point                    : 172
0
C 

Rf Value                           : 0.83 

Yield                                 : 73.36% 

Composition                     :  C(65.75%) H(4.14%) N(19.17%)  

  O(10.95%) 

Molar refractivity             :  81.21 ± 0.3 cm
3
 

Molar volume                   :  217.9 ± 3.0 cm
3
 

Parachor :  611.7 ± 4.0 cm
3
 

Index of Refractivity :  1.667 ± 0.02  

Surface Tension :  62.0 ± 3.0 dyne/cm  

Polarizability :  32.19 ± 0.5 10
-24

cm
3
 

 

2‐ [5‐ (2‐ methyl‐ 1,3‐ benzoxazol‐ 5‐ yl)‐ 1,3,4‐ oxadiazol‐ 2‐ yl]aniline 



EXPERIMENTAL WORK 

Department of Pharmaceutical Chemistry, COP, MMC. Page 106 

INFRARED SPECTRUM OF VD3: 

 

 

Figure.no.25: IR Spectrum of Compound VD3 

 

Table.no.12: IR Interpretation of compound VD3  

 

S.NO 

 

WAVE NUMBER (cm
-1

) 

 

FUNCTIONAL GROUPS 

 

1 

 

1681 

 

C=N Stretching 

 

2 

 

1589 

 

- C=C- 

 

3 

 

3317 

 

NH2 

 

4 

 

2962 

 

SP2-C-H stretching 

 

5 

 

1280 

 

C-O-C Stretching 
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LC-MS SPECTRUM OF VD3: 

 

 

 

 

 

 

 

 

 

Figure.no.26: Chromatogram of Compound VD3 

 

 

 

 

 

 

 

 

 

 

Figure.no.27: Mass Spectrum of Compound VD3 
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PROTON NMR SPECTRUM OF VD3: 

 

 

 

 

 

 

 

 

Figure .no.28: 
1
H NMR Spectrum of Compound VD3 

 

 

Table.no.13: 
1
H NMR Interpretation of Compound VD3 

 

S.NO 

 

DELTA VALUE 

(PPM) 

 

NATURE OF 

PROTON 

 

NATURE OF 

PEAK 

 

NUMBER OF 

PROTONS 

 

1 

 

2.51 

 

Methyl C-H 

 

singlet 

 

3 

 

2 

 

7.4-8.7 

 

Aromatic C-H 

 

Multiplet 

7 

 

3 

 

6.8 

 

NH2 

 

Singlet 

 

2 
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VD4 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Molecular Formula :  C16H13N5O 

Formula Weight :  291.30732 

Appearance               :  Pink 

Melting Point                    : 180
0
C 

Rf Value                           : 0.54 

Yield                                 : 75.36% 

Composition                     :  C(65.97%) H(4.50%) N(24.04%)  

  O(5.49%) 

Molar refractivity             :  82.32 ± 0.3 cm
3
 

Molar volume                   :  203.4 ± 3.0 cm
3
 

Parachor :  565.1 ± 8.0 cm
3
 

Index of Refractivity :  1.743 ± 0.05  

Surface Tension :  59.5 ± 7.0 dyne/cm  

Polarizability :  32.63 ± 0.5 10
-24

cm
3
 

 

3‐ (2‐ methyl‐ 1,3‐ benzoxazol‐ 5‐ yl)‐ 5‐ phenyl‐ 4H‐ 1,2,4‐ triazol‐  

4‐ amine 
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INFRARED SPECTRUM OF VD4: 

 

 

 

 

Figure.no.29: IR Spectrum of Compound VD4 

 

Table.no.14: IR Interpretation of compound VD4  

 

S.NO 

 

WAVE NUMBER (cm
-1

) 

 

FUNCTIONAL GROUPS 

 

1 

 

1643 

 

C=N Stretching 

 

2 

 

1535 

-C=C- 

 

3 

 

3309 

NH2 

 

4 

 

3147 

SP-C-H Stretching 

 

5 

 

2839 

-SP2-C-H stretching 
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LC-MS SPECTRUM OF VD4: 

 

 

Figure.no.30: LC-MS Spectrum of Compound VD4 

 

 

 

 

 

 

 

 

 

 

 

 

Figure.no.31: Mass Spectrum of Compound VD4 
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PROTON NMR SPECTRUM OF VD4: 

 

 

 

 

 

 

 

 

 

Figure.no.32: 
1
H NMR Spectrum of Compound VD4 

 

 

Table.no.15: 
1
H NMR Interpretation of Compound VD4 

 

S.NO 

 

DELTA VALUE 

(PPM) 

 

NATURE OF 

PROTON 

 

NATURE OF 

PEAK 

 

NUMBER OF 

PROTONS 

 

1 

 

2.5 

 

Methyl C-H 

 

singlet 

 

3 

 

2 

 

7.7-8.0 

 

Aromatic C-H 

 

Multiplet 

8 

 

3 

 

6.6 

 

NH2 

 

Singlet 

 

2 
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VD5 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Molecular Formula :  C17H15N5O 

Formula Weight :  305.3339 

Appearance               :  Pink 

Melting Point                    : 190
0
C 

Rf Value                           : 0.71 

Yield                                 : 74.36% 

Composition                     :  C(66.87%) H(4.95%) 

N(22.94%) 

  O(5.24%) 

Molar refractivity             :  86.74 ± 0.5 cm
3
 

Molar volume                   :  218.6 ±7.0 cm
3
 

Parachor :  592.2 ± 8.0 cm
3
 

Index of Refractivity :  1.724 ± 0.05  

Surface Tension :  55.2 ± 7.0 dyne/cm  

Polarizability :  34.38 ± 0.5 10
-24

cm
3
 

3‐ (2‐ methyl‐ 1,3‐ benzoxazol‐ 5‐ yl)‐ 5‐ (4-methylphenyl)‐ 4H‐ 1,2,4‐

triazol‐ 4‐ amine 
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INFRARED SPECTRUM OF VD5: 

 

 

 

 

Figure.no.33: IR Spectrum of Compound VD5 

 

Table.no.16: IR interpretation of compound VD5  

 

S.NO 

 

WAVE NUMBER (cm
-1

) 

 

FUNCTIONAL GROUPS 

 

1 

 

1681 

 

C=N Stretching 

 

2 

 

1589 

 

- C=C- 

 

3 

 

3309 

 

NH2 Stretching 

 

4 

 

3031 

 

SP-C-H Stretching 

 

5 

 

2962 

 

SP2-C-H Stretching 
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LC-MS SPECTRUM OF VD5: 

 

 

 

Figure.no.34: Chromatogram of Compound VD5 

 

 

 

 

 

 

 

 

 

 

Figure.no.35: Mass Spectrum of Compound VD5 
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PROTON NMR SPECTRUM OF VD5: 

 

 

 

 

 

 

 

 

Figure.no.36: 
1
HNMR Spectrum of Compound VD5 

 

Table.no.17: 
1
H NMR interpretation of Compound VD5 

 

S.NO 

 

DELTA VALUE 

(PPM) 

 

NATURE OF 

PROTON 

 

NATURE OF 

PEAK 

 

NUMBER OF 

PROTONS 

 

1 

 

2.4 

 

Methyl C-H 

 

Singlet 

 

3 

 

2 

 

7.80-7.82 

 

Aromatic C-H 

 

Multiplet 

 

7 

 

3 

 

6.8 

 

NH2 

 

Singlet 

 

2 
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MOLECULAR MASS OF THE SYNTHESIZED COMPOUNDS 

Table.no.18: Molecular mass of synthesized compounds 

 

SAMPLE CODE 

 

CALCULATED MASS 

 

ACTUAL MASS 

 

VD1 

 

292.30 

 

292.05 

 

VD2 

 

293.28 

 

294.300 

 

VD3 

 

292.30 

 

293.65 

 

VD4 

 

291.31 

 

293.100 

 

VD5 

 

305.34 

 

306.25 
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V.C. PHARMACOLOGICAL EVAUATION 

V.C.I. MATERIALSAND METHODS 

IN VIVO ANTIHYPERLIPIDEMIC ACTIVITY 

Experimental animals 

Male Wistar Albino rats of (150-180g) were procured from the Animal Experimental 

Laboratory, Madras Medical College, Chennai-03. The study was approved by the 

Institutional Animal Ethical Committee (IAEC) of Madras Medical College, Chennai which 

was certified by the Committee for the Purpose of Control and Supervision of Experiments of 

Animals (CPCSEA), India. (CPCSEA Registration number:1917/GO/ReBi/2016/CPCSEA). 

Approval Number: 13/2021-2022 

Maintenance of animals 

Animals were kept in clean and dry polypropylene cages with 12:12 hours light and 

dark cycle at 25±5
0
C and 55-58% relative humidity in the animal house. Animals were 

allowed freely to access standard pellet diet and purified water ad libitum. 

i. ACUTE ORAL TOXICITY STUDY(ACUTE TOXIC CLASS METHOD ) 

Acute oral toxicity defines to the adverse effects occurring following oral 

administration of single dose of substances or multiple doses given within 24hrs. 

The different methods used to evaluate the acute oral toxicity studies are as follows, 

i. Fixed dose procedure(OECD Guidelines- 420) 

ii. Acute toxic class method (OECD Guidelines- 423) 

iii. Ups and down procedure(OECD Guidelines- 425) 

Our study was done following acute toxic class method (OECD Guidelines- 423) 

OECD Guidelines – 423 

OECD Guidelines for the testing of chemicals are periodically reviewed in the light of 

scientific progress or changing assessment practices. The original guidelines 423 was adopted 

in March 1996 as the second alternative to the conventional acute toxicity test, described in 

the guideline 401. Based on the recommendation of several expert meetings, revision was 

considered timely because international agreement has been reached on harmonized LD50. 
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Cut-off value for the classification of the chemical substances, which differ from the cut-off 

recommended in the 1996 version of the guidelines and testing in one sex (usually female) is 

now considered sufficient. 

A. Acute toxic class method 

In the present study, the oral toxicity of the synthesized compounds were performed by 

acute toxic class method. In these methods, the toxicity of the synthesized compounds was 

tested using a stepwise procedure, each step using 3 rats of a single sex. The various 

concentration of test drug as per OECD Guidelines are as follows, wistar rats were fasted 

overnight prior to dosing (food but not water should be withheld). Following the period of 

fasting the animal should be weighed and the synthesized compounds administered orally at 

the dose of 2000mg/kg body weight. Animals were observed individually after dosing at least 

during the first four hours and daily thereafter, for a total of 14 days
63

. The test procedure 

with starting doses of 2000mg/kg body weight as per OECD-423 Guidelines was shown as 

follows. 

Figure.no.37: Treatment protocol for the acute toxicity study (OECD-423) 
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ii. IN VIVO ANTIHYPERLIPIDEMIC ACTIVITY 

 The model used to evaluate the antihyperlipidemic activity was High Fat Diet induced 

hyperlipidemia in rats. Hyperlipidemia in rats was induced by administration of high fat diet 

(43% carbohydrate, 17%protein and 40% fat, each nutrient per 100g) for 60 days with 

standard rat chow diet
65

. 

Experimental Design 

30 Male Wistar rats were used in this study. The animals were divided into 5 groups 

of 6 animals each.  

Table.no.19: Experimental design 

GROUP 

(n=6) 

NAME OF THE 

GROUP 
TREATMENT SCHEDULE 

A Normal Control Standard Rat chow diet for 60 days 

B Disease Control High fat diet for 60 days 

C Low dose 
High fat diet for 60 days +Low dose of VD1 p.o 

from 31
st
 to 60

th
 day 

D High dose 
High fat diet for 60 days +High dose of VD1 p.o 

from 31
st
 to 60

th
 day 

E Standard control 
High fat diet for 60 days + Atorvastatin, 

(1.2mg/kg) p.o from 31
st
 to 60

th
 day 

 

EVALUATION PARAMETERS 

A. Body weight 

         During study period, the rats were weighed periodically using electronic balance and 

their body weight was recorded. 
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B. Biochemical estimation 

At the end of experiment, the rats were fasted overnight. The rats were weighed and 

euthanized using light anaesthesia of Isoflurane. The blood was collected by cardiac puncture 

in non-heparinised tubes for serum separation. The clear serum was separated by 

centrifugation at 2500 rpm for 10 minutes and used for the determination of biochemical 

parameters such as total cholesterol, LDL-cholesterol, HDL-cholesterol, VLDL and 

triglycerides. Atherogenic index were calculated using the formula  

 

 

 

C. Histopathological analysis 

The liver and heart was isolated from each rat in all groups and then fixed in 10% 

neutral buffered formalin. The specimen were cleared in xylene and embedded in wax with 

paraffin. Then cut into 4-6 microns thickness using a rotary microtome and stained with 

haematoxylin and eosin. This section was observed under microscope. 

STATISTICAL ANALYSIS 

 Data are presented as Mean ± SEM and the values of P< 0.01 were considered 

statistically significant. Statistical analysis between the control and experimental groups was 

analyzed using one-way ANOVA followed by Dunnetts’s multiple comparison test using 

Graph Pad Prism 8.0.2. 

 

 

 

 

 

 

 

AI = (TC-HDL) /HDL 
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V.C.II.RESULTS AND DISCUSSION 

i. Acute toxicity study  

Oral acute toxicity of newly synthesized heterocyclic compounds such as VD1, VD2, 

VD3, VD4 and VD5 were performed and the results were illustrated in Table.no.20. 

Table.no.20: Acute toxicity study 

OBSERVATIONS 30 mins 4 hrs 24 hrs 14
th

day 

Alertness Present Present Present Present 

Aggressiveness Absent Absent Absent Absent 

Touch response Present Present Present Present 

Gripping Present Present Present Present 

Motor co-ordination Present Present Present Present 

Catatonia Absent Absent Absent Absent 

Righting reflux Present Present Present Present 

Corneal reflux Present Present Present Present 

Lacrimation Normal Normal Normal Normal 

Salivation Normal Normal Normal Normal 

Writhing effect Absent Absent Absent Absent 

Diarrhoea Absent Absent Absent Absent 

Tremors Absent Absent Absent Absent 

Convulsions Absent Absent Absent Absent 

Death Absent Absent Absent Absent 
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In acute toxicity studies it was found that the animals were safe up to a maximum 

dose of 2000mg/kg of body weight. There were no changes in normal behaviour pattern, no 

signs and symptoms of toxicity and mortality were observed up to the dose of 2000mg/kg of 

body weight. As no mortality was observed with the above doses a series of doses 100 & 

200mg/kg body weight were selected for the further pharmacological evaluation 

ii. IN VIVO ANTIHYPERLIPIDEMIC ACTIVITY 

A. Effect of compound VD1 on body weight of animal 

Rats treated with HFD (Hyperlipidemic rats) showed a considerable increase in body 

weight whereas control rats remained the same. Atrovastatin and test compound treated group 

showed significant reduction in the body weight of animals. Results are illustrated in 

Table.no.21. 

Table.no.21: Body weight variation in control and experimental wistar rats 

Table 1 

 

GROUP 

 

INITIAL WEIGHT (g) 

 

FINAL WEIGHT (g) 

 

WEIGHT GAIN (g) 

 

A 

 

132.91±1.74 

 

174.06±2.38 

 

35.26±4.39 

 

B 

 

136.84±2.53 

 

254.14±8.58 

 

117.44±6.05 

 

C 

 

150.66±1.26 

 

220.90±7.51 

 

70.33±5.87 

 

D 

 

153.58±2.32 

 

195.78±3.10 

 

42.26±3.34 

 

E 

 

177.83±2.29 

 

218.47±3.78 

 

40.76±3.37 

 

All the values are expressed as Mean ± SEM (n=6). 
###

P < 0.001 compared to normal 

control group, 
***

P < 0.001 compared to disease control group 
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B. Biochemical Estimation 

1. Effect of compound VD1 on TC in hyperlipidemic rats 

Table.no.22: Effect of compound VD1 on TC in hyperlipidemic rats 

GROUP TREATMENT TC(mg/dl) 

A Normal Control 
 

111.83±1.137 

B Disease control 
 

180.83±1.013 

C HFD + Test compound (100mg/kg) 
 

145.51±1.335 

D HFD + Test compound (200mg/kg) 
 

120.16±1.137 

 

E HFD + Atorvastatin (1.2mg/kg) 113.5±1.408 

 

All the values are expressed as Mean ± SEM (n=6). 
###

P < 0.001 compared to normal 

control group, 
***

P < 0.001 compared to disease control group 
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Figure.no.38: Effect of compound VD1 on TC in hyperlipidemic rat 

As illustrated in Table.no.22 and figure.no.38, there was a significant rise (P<0.001) 

in TC levels in HFD induced hyperlipidemic rats when compared to normal group. The 

administration of Atorvastatin has significant (P<0.001) lowering of TC level compared to 

group B. The administration of compound VD1at 200mg/kg has showed a significant 

lowering (P<0.001) of TC level when compared to Group B (HFD induced hyperlipidemic 

rats). 
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2. Effect of compound VD1 on TG in hyperlipidemic rats 

Table.no.23: Effect of compound VD1 on TG in hyperlipidemic rats 

GROUP TREATMENT TG (mg/dl) 

A Normal Control 
84.66±1.382 

B Disease control 
159.83±1.301 

C HFD + Test compound (100mg/kg) 
115.16±1.424 

D HFD + Test compound (200mg/kg) 
96.83±1.249 

 

E HFD + Atorvastatin (1.2mg/kg) 
92.66±1.406 

 

All the values are expressed as Mean ± SEM (n=6). 
###

P < 0.001 compared to normal 

control group, 
***

P < 0.001 compared to disease control group 
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Figure.no.39: Effect of compound VD1 on TG in hyperlipidemic rat 

As illustrated in Table.no.23 and Figure.no.39, there was a significant rise (P<0.001) 

in TG levels in HFD induced hyperlipidemic rats when compared to normal group. The 

administration of Atorvastatin has significant (P<0.001) lowering of TG level compared to 

group B. The administration of compound VD1at 200mg/kg has showed a significant 

lowering (P<0.001) of TG level when compared to Group B (HFD induced hyperlipidemic 

rats). 
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3. Effect of compound VD1 on HDL in hyperlipidemic rats 

Table.no.24: Effect of compound VD1 on HDL in hyperlipidemic rats 

GROUP TREATMENT HDL (mg/dl) 

A Normal Control 
58.66±1.282 

B Disease control 
25.66±0.954 

C HFD + Test compound (100mg/kg) 
39.66±1.115 

D HFD + Test compound (200mg/kg) 
51.5±1.586 

E HFD + Atorvastatin (1.2mg/kg) 
54.5±1.335 

All the values are expressed as Mean ± SEM (n=6). 
###

P < 0.001 compared to normal 

control group, 
***

P < 0.001 compared to disease control group. 
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 Figure.no.40: Effect of compound VD1 on HDL in hyperlipidemic rat 

As illustrated in Table.no.24 and Figure.no.40, there was a significant decline 

(P<0.001) in HDL levels in HFD induced hyperlipidemic rats when compared to normal 

group. The administration of Atorvastatin has significant (P<0.001) increase of HDL level 

compared to group B. The administration of compound VD1at 200mg/kg has showed a 

significant increase (P<0.001) of HDL level when compared to Group B (HFD induced 

hyperlipidemic rats). 
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4. Effect of compound VD1 on LDL in hyperlipidemic rats 

Table.no.25: Effect of compound VD1 on LDL in hyperlipidemic rats 

GROUP TREATMENT LDL (mg/dl) 

A Normal Control 
37.83±1.740 

 

 

B Disease control 
113.5±1.231 

 

C HFD + Test compound (100mg/kg) 
66.33±1.145 

 

D HFD + Test compound (200mg/kg) 
46.83±1.249 

 

E HFD + Atorvastatin (1.2mg/kg) 
42.16±1.833 

All the values are expressed as Mean ± SEM (n=6). 
###

P < 0.001 compared to normal 

control group, 
***

P < 0.001 compared to disease control group. 
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  Figure.no.41: Effect of compound VD1 on LDL in hyperlipidemic rat 

As illustrated in Table.no.25, there was a significant rise (P<0.001) in LDL levels in 

HFD induced hyperlipidemic rats when compared to normal group. The administration of 

Atorvastatin has significant (P<0.001) decrease of LDL level compared to group B. The 

administration of compound VD1at 200mg/kg has showed a significant decrease (P<0.001) 

of LDL level when compared to Group B (HFD induced hyperlipidemic rats). 
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5. Effect of compound VD1 on VLDL in hyperlipidemic rats 

Table.no.26: Effect of compound VD1 on VLDL in hyperlipidemic rats 

GROUP TREATMENT VLDL (mg/dl) 

A Normal Control 
19.66±1.333 

 

B Disease control 
35.16±1.337 

C HFD + Test compound (100mg/kg) 
29.16±1.301 

D HFD + Test compound (200mg/kg) 
23.83±1.424 

E HFD + Atorvastatin (1.2mg/kg) 
21.83±1.137 

All the values are expressed as Mean ± SEM (n=6). 
###

P < 0.001 compared to normal 

control group, 
***

P < 0.001 compared to disease control group. 
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 Figure.no.42: Effect of compound VD1 on VLDL in hyperlipidemic rat 

As illustrated in Table.no.26, there was a significant rise (P<0.001) in VLDL levels in 

HFD induced hyperlipidemic rats when compared to normal group. The administration of 

Atorvastatin has significant (P<0.001) decrease of VLDL level compared to group B. The 

administration of compound VD1at 200mg/kg has showed a significant decrease (P<0.001) 

of VLDL level when compared to Group B (HFD induced hyperlipidemic rats). 
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6. Effect of compound VD1 on AI in hyperlipidemic rats 

Table.no. 27: Effect of compound VD1 on AI in hyperlipidemic rats 

GROUP TREATMENT AI 

A Normal Control 
0.91±0.046 

B Disease control 
6.09±0.278 

C HFD + Test compound (100mg/kg) 
2.68±0.123 

 

D HFD + Test compound (200mg/kg) 
1.34±0.076 

E HFD + Atorvastatin (1.2mg/kg) 
1.08±0.054 

All the values are expressed as Mean ± SEM (n=6). 
###

P < 0.001 compared to normal 

control group, 
***

P < 0.001 compared to disease control group. 

A B C D E

0

2

4

6

8

A th e ro s c le ro t ic  In d e x

G ro u p

A
I

A  -  N o r m a l  c o n tr o l

B  -  D i s e a s e  C o n t r o l

C  -  L o w  D o s e  t r e a t m e n t

D  -  H ig h  D o s e  t r e a t m e n t

E  -  S ta n d a r d  tr e a tm e n t

# # #

* * *

* * * * * *

 

 Figure.no.43: Effect of compound VD1 on AI in hyperlipidemic rat 

As illustrated in Table.no.27, there was a significant rise (P<0.001) in AI levels in HFD 

induced hyperlipidemic rats when compared to normal group. The administration of 

Atorvastatin has significant (P<0.001) decrease of AI level compared to group B. The 

administration of compound VD1at 200mg/kg has showed a significant decrease (P<0.001) 

of AI level when compared to Group B (HFD induced hyperlipidemic rats). 
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C. Histopathological studies 

Effect on liver 

The liver section was examined for Histopathological changes and the results were illustrated 

in the Figure.no.44 

  

Normal Control Disease Control 

 
 

Test Low dose Test High dose 

 

Standard control 

Figure 44: Histopathology of Rat Liver 
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Effect on Heart 

The heart section was examined for Histopathological changes and the results were illustrated 

in the Figure.no.45 
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Figure.no.45: Histopathology of Rat Heart 
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Histopathology of liver: 

 The HFD induced hyperlipidemia and abnormal lipid metabolism all collectively 

associated with inflammation, congestion, minimal to mild periportal mononuclear cell 

infiltration. Histopathological studies showed that the liver section was normal in normal 

control group. The HFD treated group showed marked ballooning, cellular degeneration. 

These changes were absent in atorvastatin treated standard group. Test compound 

VD1(100mg/kg) treated group showed decrease in cellular degeneration and congestion when 

compared to normal group. Test compound VD1(200mg/kg) treated group showed maximum 

suppression of cellular degeneration and inflammation.  

Histopathology of Heart: 

 Histopathological section of heart of normal control showed normal cardiac muscle 

fiber. Section of heart of HFD induced hyperlipidemic group showed excessive fatty 

infiltration of the myocardium. Heart section of standard group showed cardiac muscle with 

minimal infiltration. Cross-section of test group (200 mg/kg) showed cardiac muscle with 

minimal fatty infiltration.  
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VI. SUMMARY AND CONCLUSION 

SUMMARY 

Medicinal chemistry primarily aims to discover novel chemical molecule which have 

the potential to prevent or treat a disease / infection. According to the WHO reports, 

Hyperlipidemia is one of the leading causes of death globally. Therefore, the current work 

aimed to design and synthesize some novel antihyperlipidemic compounds.  

Based on the literature review, PCSK9 has been considered as potential therapeutic 

target for selective LDLR regulation in the treatment of hyperlipidemia. Based on the 

literature review, pharmacophoric features such as 1 HBD, 1 HBA and 1 Aromatic ring 

were identified. Hence a scaffold library has been generated with 150 newly designed ligands 

which were screened with high docking score against PCSK9 using Autodock4.2.6. software 

and further optimized by drug likeliness properties such as Lipinski rule of five and ADMET 

properties. All the designed ligands were found to obey lipinski’s rule of five and possess 

drug likeliness property. Results of the in silico toxicity studies showed that all the designed 

compounds found to be non-toxic.  

Based on high docking scores and synthetic feasibility ligand 7, ligand 8, ligand 10, 

ligand 12 and ligand 13 was selected for synthesis. All the selected ligands were chemically 

synthesized with different aromatic carboxylic acids. Completion of the reaction was 

determined by TLC.  The synthesized compounds are labelled as VD1, VD2, VD3, VD4 and 

VD5. The purity of the synthesized compounds was checked by determining Melting point. 

The chemical nature of synthesized compounds was characterized by different spectral 

studies such as IR, 
1
HNMR and LC- MS spectroscopy.  

All the synthesized compounds were subjected to acute oral toxicity studies as per the 

OECD Guidelines 423 to access the toxicity and also to fix the dose. The LD50 value of the 

test compound VD1, VD2, VD3, VD4 and VD5 does not found to 2000mg/kg and also no 

mortality was observed. Based on high docking score CompoundVD1 was selected for 

further pharmacological evaluation. The dose 100mg/kg and 200mg/kg were selected..  

In vivo antihyperlipidemic activity was evaluated for compound VD1 against HFD 

induce Hyperlipidemia in wistar rats. The rats were divided into five groups of 6 animals 

each. 
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From In vivo activity study, it was found that the body weight of Group B rats (rats 

treated with HFD) were significantly increased (P<0.001) in comparison with normal control 

rats. The increment in the body weight was reduced considerably (P<0.001) by the 

administration of Atorvastatin and test compound VD1 (200mg/kg and 100mg/kg). However, 

Group D (200mg/kg) showed decrease in body weight to normal as that of Group E.  

The level of serum TC, TG, LDL, VLDL were significantly increased (P<0.001) in 

disease Control group in comparison with normal control group. Administration of test 

compound VD1 at the dose of 100mg/kg and 200mg/kg showed considerable reduction in 

serum TC, TG, LDL, VLDL in comparison with disease control. In comparison of the two 

doses of test group, the test compound at the dose of 200mg/kg was revealed considerable 

reduction of LDL and VLDL as that of Atorvastatin treated group.  

The level of serum HDL were significantly decreased (P<0.001) in disease Control 

group in comparison with normal control group. Administration of test compound VD1 at the 

dose of 100mg/kg and 200mg/kg showed considerable raised serum HDL in comparison with 

disease control. In comparison of the two doses of test group, the test compound at the dose 

of 200mg/kg was revealed considerable raise in HDL as that of Atorvastatin treated group. 

It has been shown that the Atherogenic index is strong marker to predict the risk of 

atherosclerosis and CVD. Test compound showed significant reduction of AI in compared to 

disease control group. 

From the histopathological studies, the compound VD1 at 200mg/kg normalize the 

tissue of both liver and heart compared to disease control group. 
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CONCLUSION 

 Drug design approach as well as clinical studies has revealed that the PCSK9 have a 

crucial role in LDLR regulation for the treatment of Hyperlipidemia. The present study also 

provides important structural insight of benzoxazole, amino triazole and oxadiazole in 

designing better PCSK9 inhibitor as potent antihyperlipdimic agents. The designed 

compounds were docked against PCSK9 using Autodock4.2.6. The synthesized compounds 

VD1, VD2, VD3, VD4 and VD5 found to obey Lipinski’s rule of five and also possess drug 

likeliness property. Based on high docking score Compound VD1 has been selected for 

evaluating in vivo antihyperlipidemic activity and it found to reduce LDL level effectively 

with significance of P value 0.001 when compared to the standard drug Atorvastatin.  

 Further evaluation studies including in vitro, in vivo antihyperlipidemic screening and 

PCSK9 enzyme Inhibition assay method using ELISA kit. will be performed for all the 

remaining synthesized compound (VD2, VD3, VD4, VD5) in future.  
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